Micro Motion® Marine Bunker Transfer Package

Certified Marine Bunker Measurement Solution
Micro Motion customer service

Email:
- Worldwide: flow.support@emerson.com
- Asia-Pacific: APflow.support@emerson.com

Telephone:

<table>
<thead>
<tr>
<th>North and South America</th>
<th>Europe and Middle East</th>
<th>Asia Pacific</th>
</tr>
</thead>
<tbody>
<tr>
<td>United States</td>
<td>800-522-6277</td>
<td>Australia</td>
</tr>
<tr>
<td>Canada</td>
<td>+1 303-527-5200</td>
<td></td>
</tr>
<tr>
<td>Mexico</td>
<td>+41 (0) 41 7686 111</td>
<td>Europe and Middle East</td>
</tr>
<tr>
<td>Argentina</td>
<td>+54 11 4837 7000</td>
<td>Germany</td>
</tr>
<tr>
<td>Brazil</td>
<td>+55 15 3413 8000</td>
<td>Italy</td>
</tr>
<tr>
<td>Venezuela</td>
<td>+58 26 1731 3446</td>
<td>Central &amp; Eastern</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Russia/CIS</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Egypt</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Oman</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Qatar</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Kuwait</td>
</tr>
<tr>
<td></td>
<td></td>
<td>South Africa</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Saudia Arabia</td>
</tr>
<tr>
<td></td>
<td></td>
<td>UAE</td>
</tr>
</tbody>
</table>
# Contents

<table>
<thead>
<tr>
<th>Chapter 1</th>
<th>Orientation and planning</th>
<th>1</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.1</td>
<td>About this application manual</td>
<td>1</td>
</tr>
<tr>
<td>1.2</td>
<td>Overview of the Micro Motion Certified Marine Bunker Measurement Solution</td>
<td>1</td>
</tr>
<tr>
<td>1.3</td>
<td>System types and requirements for the Marine Bunker Transfer Package</td>
<td>5</td>
</tr>
<tr>
<td>1.4</td>
<td>Additional documentation</td>
<td>9</td>
</tr>
<tr>
<td>Chapter 2</td>
<td>Install the Series 3000 transmitter with the Marine Bunker Transfer Package</td>
<td>11</td>
</tr>
<tr>
<td>2.1</td>
<td>System options and installation instructions</td>
<td>11</td>
</tr>
<tr>
<td>2.2</td>
<td>Install the Basic system</td>
<td>11</td>
</tr>
<tr>
<td>2.3</td>
<td>Install the Basic/MID system</td>
<td>15</td>
</tr>
<tr>
<td>2.4</td>
<td>Install the Profile system</td>
<td>18</td>
</tr>
<tr>
<td>2.5</td>
<td>Install the Profile/MID system</td>
<td>23</td>
</tr>
<tr>
<td>2.6</td>
<td>Install ferrite beads in transmitter wiring (if required)</td>
<td>28</td>
</tr>
<tr>
<td>Chapter 3</td>
<td>Start up the system</td>
<td>31</td>
</tr>
<tr>
<td>3.1</td>
<td>Power up the system</td>
<td>31</td>
</tr>
<tr>
<td>3.2</td>
<td>Perform optional startup tasks</td>
<td>32</td>
</tr>
<tr>
<td>Chapter 4</td>
<td>Configure the system using the transmitter display</td>
<td>33</td>
</tr>
<tr>
<td>4.1</td>
<td>Configure auxiliary devices</td>
<td>33</td>
</tr>
<tr>
<td>4.2</td>
<td>Configure basic flowmeter parameters</td>
<td>34</td>
</tr>
<tr>
<td>4.3</td>
<td>Configure bunker ticket options using the transmitter display</td>
<td>38</td>
</tr>
<tr>
<td>4.4</td>
<td>Configure communications</td>
<td>41</td>
</tr>
<tr>
<td>4.5</td>
<td>Secure and seal the transmitter</td>
<td>44</td>
</tr>
<tr>
<td>Chapter 5</td>
<td>Operate the system from the transmitter display</td>
<td>47</td>
</tr>
<tr>
<td>5.1</td>
<td>Transfer a bunker and print a ticket</td>
<td>47</td>
</tr>
<tr>
<td>5.2</td>
<td>Transfer a bunker, collect profile data, and print a ticket and/or a profile report</td>
<td>50</td>
</tr>
<tr>
<td>5.3</td>
<td>Marine Bunkering dashboard during bunker transfer</td>
<td>53</td>
</tr>
<tr>
<td>5.4</td>
<td>Process variables during a bunker transfer</td>
<td>54</td>
</tr>
<tr>
<td>5.5</td>
<td>Process noise due to vibration</td>
<td>55</td>
</tr>
<tr>
<td>5.6</td>
<td>Contents of bunker ticket for Basic and Profile systems</td>
<td>55</td>
</tr>
<tr>
<td>5.7</td>
<td>Contents of bunker ticket for Basic/MID and Profile/MID systems</td>
<td>61</td>
</tr>
<tr>
<td>5.8</td>
<td>Retrieve and reprint bunker tickets using the transmitter display</td>
<td>68</td>
</tr>
<tr>
<td>Chapter 6</td>
<td>Use ProLink II with the Marine Bunkering Transfer Package</td>
<td>69</td>
</tr>
<tr>
<td>6.1</td>
<td>Configure bunker ticket options using ProLink II</td>
<td>69</td>
</tr>
<tr>
<td>6.2</td>
<td>Transfer a bunker using ProLink II</td>
<td>72</td>
</tr>
<tr>
<td>6.3</td>
<td>Print or reprint a bunker ticket using ProLink II</td>
<td>74</td>
</tr>
<tr>
<td>6.4</td>
<td>View bunker transfer history</td>
<td>75</td>
</tr>
<tr>
<td>6.5</td>
<td>Contents of profile report</td>
<td>76</td>
</tr>
<tr>
<td>6.6</td>
<td>Print or export bunker transfer data using ProLink II</td>
<td>80</td>
</tr>
<tr>
<td>6.7</td>
<td>Maintain bunker transfer history</td>
<td>80</td>
</tr>
</tbody>
</table>

## Appendices and reference

### Appendix A | Integrated wiring diagrams | 83 |
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>A.1</td>
<td>Integrated wiring diagrams for Basic systems</td>
<td>83</td>
</tr>
<tr>
<td>A.2</td>
<td>Integrated wiring diagrams for Basic/MID systems</td>
<td>88</td>
</tr>
</tbody>
</table>
Contents

A.3  Integrated wiring diagrams for Profile systems ................................................................. 93
A.4  Integrated wiring diagrams for Profile/MID systems ...................................................... 98

Appendix B  Printer setup ........................................................................................................ 103
B.1  Communications settings for the ticket printer ............................................................. 103

Index ................................................................................................................................................105
1 Orientation and planning

Topics covered in this chapter:

- About this application manual
- Overview of the Micro Motion Certified Marine Bunker Measurement Solution
- System types and requirements for the Marine Bunker Transfer Package
- Additional documentation

1.1 About this application manual

This application manual provides information required to install and operate the Series 3000 transmitter with the Marine Bunker Transfer Package.

This application manual is designed for use with the following manual: Micro Motion Series 3000 MVD Transmitters and Controllers: Configuration and Use Manual.

This application manual assumes that the transmitter display is used as the primary configuration and operation method. However, ProLink II can be used for most configuration and operation tasks. ProLink II also provides additional reporting and history features. Use of ProLink II is documented in Chapter 6.

Important
Use this application manual as your main guide for installation, configuration, and operation. You will be referred to other documentation for specific tasks and information.

1.2 Overview of the Micro Motion Certified Marine Bunker Measurement Solution

The Micro Motion Certified Marine Bunker Measurement Solution is a system that provides a complete solution for the measurement of marine fuel delivery. The system monitors aeration (entrained gas or entrained air), and supplies a bunker ticket with time and date, total amount transferred, and other relevant data.

The Certified Marine Bunker Measurement Solution includes an approved sensor, a Series 3000 transmitter, the Marine Bunker Transfer Package application running on the transmitter, the appropriate components from the Marine Bunker Instruments offering, and Micro Motion field services.
1.2.1 Marine Bunker Transfer Package

The Marine Bunker Transfer Package is a software application installed on a Series 3000 transmitter. The Marine Bunker Transfer Package manages the specialized measurement, monitoring, and ticket printing functions of the Certified Marine Bunker Measurement Solution. For Profile and Profile/MID systems, the Marine Bunker Transfer Package also handles communication with ProLink II.

Measurement

The Marine Bunker Transfer Package provides flow measurement data that complies with OIML R117-1 and MID 2004/22/EC Annex MI-005. If the appropriate security hardware is installed, the system has been accredited by a certified technician, and OIML/MID-approved procedures are followed, the bunker ticket can be used as a legal (Weights & Measures) document.

OIML R117-1 compliance

The Marine Bunker Transfer Package is designed to comply with measurement and operational requirements established by OIML. After the initial startup and certification, OIML R117-1 compliance includes four factors, or checks. For bunker transfer measurement data to meet OIML R117-1 requirements, the bunker transfer must pass all four checks.

The four checks are as follows:

• MMQ check: The size of the bunker transfer is above the threshold defined by Minimum Measured Quantity (MMQ). MMQ is specified during system certification.

• Max Aeration check: The potential measurement error due to aeration (entrained gas or entrained air), in combination with other sources of measurement error, is within MID limits as defined in MID 2004/22/EC Annex MI-005. The Aeration Limit diagnostic is used to monitor this factor.

• Power check: Power was continuous during the transfer (no power interrupt).

• Alarm check: No “bunker-critical” alarms have occurred since the last time a bunker ticket was printed.

If the bunker transfer fails one or more of these checks, the bunker transfer measurement data does not meet OIML R117-1 requirements and the ticket will show Overall OIML R117-1: Fail.

Note

Aeration Limit is always calculated and the four checks are always applied, whether or not an OIML/MID-compliant system was purchased and installed. If the system is not OIML/MID-compliant, there is no system performance traceability regardless of overall bunker pass/fail results.

Minimum Measured Quantity (MMQ)

Minimum Measured Quantity (MMQ) defines the minimum quantity of fuel in a bunker transfer that is necessary to meet OIML/MID requirements.
MMQ is used to ensure that the bunker is sized appropriately for the sensor, and also to ensure that various factors related to starting and stopping flow do not have a significant effect on measurement accuracy. During initial system configuration, the service technician calculates and configures a site-specific value for MMQ. This value is typically not changed unless the piping is changed.

Tip
If you need to change the value of MMQ, contact Micro Motion customer service.

If the mass total of a bunker transfer meets or exceeds MMQ, the bunker transfer passes the MMQ check.

Aeration and Aeration Limit
Aeration refers to entrained gas or entrained air in the process fluid. Aeration Limit is a real-time diagnostic that monitors the potential measurement error due to aeration and other factors, and compares the real-time value to the maximum allowable measurement error as defined by MID 2004/22/EC Annex MI-005. Aeration Limit is expressed as a percentage of the MID limit. If the value of Aeration Limit at the end of the bunker transfer is below 100%, the bunker measurement passes the Max Aeration check.

Aeration Limit is calculated continuously. During a bunker transfer, Aeration Limit can increase, decrease, or even exceed 100%. The current value of Aeration Limit is reported as follows:

- When the transfer total reaches 20% of Minimum Measured Quantity (MMQ), the display reports:
  - Medium Aeration Limit: <On> or <Off>
  - High Aeration Limit: <On> or <Off>

  The thresholds for medium and high aeration are determined by the HI PV values assigned to Discrete Event 1 and Discrete Event 2. Default settings are 20 and 75 (i.e., 20% of the maximum allowable aeration and 75% of the maximum allowable aeration).

- When the transfer total reaches 100% of MMQ, the display reports one of the following:
  - Aeration Limit Pass (xxx%)
  - Aeration Limit Fail (xxx%)

  where xxx is the current value of Aeration Limit.

The display is updated continuously, allowing the operator to take corrective action as required.

Bunker-critical alarms
If a bunker-critical alarm occurs during a bunker transfer, the transfer fails the Alarm check and the measurement cannot be used to meet OIML/MID requirements. Not all alarms are bunker-critical.
<table>
<thead>
<tr>
<th>Alarm code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>A001</td>
<td>EEPROM Error (Core Processor)</td>
</tr>
<tr>
<td>A002</td>
<td>RAM Error (Core Processor)</td>
</tr>
<tr>
<td>A003</td>
<td>No Sensor Response</td>
</tr>
<tr>
<td>A004</td>
<td>Temperature Overrange</td>
</tr>
<tr>
<td>A005</td>
<td>Mass Flow Rate Overrange</td>
</tr>
<tr>
<td>A006</td>
<td>Characterization Required</td>
</tr>
<tr>
<td>A008</td>
<td>Density Overrange</td>
</tr>
<tr>
<td>A009</td>
<td>Transmitter Initializing/Warming Up</td>
</tr>
<tr>
<td>A014</td>
<td>Transmitter Failure</td>
</tr>
<tr>
<td>A016</td>
<td>Sensor RTD Failure</td>
</tr>
<tr>
<td>A017</td>
<td>T-Series RTD Failure</td>
</tr>
<tr>
<td>A018</td>
<td>EEPROM Error (Transmitter)</td>
</tr>
<tr>
<td>A019</td>
<td>RAM Error (Transmitter)</td>
</tr>
<tr>
<td>A020</td>
<td>No Flow Cal Value</td>
</tr>
<tr>
<td>A021</td>
<td>Incorrect Sensor Type (K1)</td>
</tr>
<tr>
<td>A022</td>
<td>Configuration Database Corrupt (Core Processor)</td>
</tr>
<tr>
<td>A023</td>
<td>Internal Totals Corrupt (Core Processor)</td>
</tr>
<tr>
<td>A024</td>
<td>Program Corrupt (Core Processor)</td>
</tr>
<tr>
<td>A025</td>
<td>Boot Sector Fault (Core Processor)</td>
</tr>
<tr>
<td>A026</td>
<td>Sensor/Transmitter Communications Failure</td>
</tr>
<tr>
<td>A027</td>
<td>Security Breach</td>
</tr>
<tr>
<td>A028</td>
<td>Core Processor Write Failure</td>
</tr>
<tr>
<td>A031</td>
<td>Low Power</td>
</tr>
<tr>
<td>A032</td>
<td>Meter Verification in Progress: Outputs to Fault</td>
</tr>
<tr>
<td>A033</td>
<td>Insufficient Right/Left Pickoff Signal</td>
</tr>
<tr>
<td>A103</td>
<td>Data Loss Possible (Totals and Inventories)</td>
</tr>
<tr>
<td>A107</td>
<td>Power Reset Occurred</td>
</tr>
<tr>
<td>A115</td>
<td>No External Input or Polled Data</td>
</tr>
<tr>
<td>A129</td>
<td>Internal Error (Display)</td>
</tr>
<tr>
<td>A133</td>
<td>Integrity Breach</td>
</tr>
<tr>
<td>A134</td>
<td>Memory Error (Display)</td>
</tr>
<tr>
<td>A135</td>
<td>Transmitter/Display Communications Error</td>
</tr>
</tbody>
</table>
1.2.2 **Location**

The Certified Marine Bunker Measurement Solution can be installed on a fuel barge or a vessel, or at a terminal.

## 1.3 System types and requirements for the Marine Bunker Transfer Package

The Marine Bunker Transfer Package can be set up in four different system types. Requirements depend on the type chosen during purchase.

### Table 1-2: Marine Bunker Transfer Package system types

<table>
<thead>
<tr>
<th>System type</th>
<th>Description</th>
<th>Requirements list</th>
</tr>
</thead>
<tbody>
<tr>
<td>Basic system</td>
<td>Measure the bunker transfer and print bunker tickets only. The flow measurement and bunker tickets are not OIML/MID-approved.</td>
<td>See Table 1-3</td>
</tr>
<tr>
<td>Basic/MID system</td>
<td>Measure the bunker transfer and print bunker tickets only. The flow measurement and bunker tickets are OIML/MID-approved.</td>
<td>See Table 1-4</td>
</tr>
<tr>
<td>Profile system</td>
<td>Measure the bunker transfer and print bunker tickets and profile reports. The flow measurement and bunker tickets are not OIML/MID-approved. The profile report is not OIML/MID-approved.</td>
<td>See Table 1-5</td>
</tr>
<tr>
<td>Profile/MID system</td>
<td>Measure the bunker transfer and print bunker tickets and profile reports. The flow measurement and bunker tickets are OIML/MID-approved. The profile report is not OIML/MID-approved.</td>
<td>See Table 1-6</td>
</tr>
</tbody>
</table>

### Table 1-3: System requirements: Basic system

<table>
<thead>
<tr>
<th>Requirement</th>
<th>Component</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Platform</td>
<td>Model 3500 or Model 3700 transmitter:</td>
<td>Not available with the Model 3300 or Model 3350 controller. For marine approvals, Model 3700 required.</td>
</tr>
<tr>
<td></td>
<td>• 3500<em><strong>3</strong></em>(F or H)**</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• 3700<em><strong>3</strong></em>(F or H)**</td>
<td></td>
</tr>
<tr>
<td>Ticket printing</td>
<td>Non–MID-Approved Printer Option (Marine Bunker Instruments)[1]</td>
<td>Includes:</td>
</tr>
<tr>
<td>Configuration tool</td>
<td>ProLink II v2.94 or higher (optional) (Micro Motion Part PLK****)</td>
<td>• Standard ticket printer</td>
</tr>
<tr>
<td>Operator interface</td>
<td>Local display ProLink II v2.94 or higher (optional) (Micro Motion Part PLK****)</td>
<td>• RS-485 to RS-232 signal converter</td>
</tr>
</tbody>
</table>
Table 1-3: **System requirements: Basic system (continued)**

<table>
<thead>
<tr>
<th>Requirement</th>
<th>Component</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Additional devices (Marine Bunker Instruments)</td>
<td>Pressure instrument</td>
<td>Included automatically with order.</td>
</tr>
<tr>
<td></td>
<td>Temperature instrument</td>
<td>Included automatically with order. Used only to correct volume measure-</td>
</tr>
<tr>
<td></td>
<td></td>
<td>ments to reference temperature, and not required for MID approval.</td>
</tr>
<tr>
<td></td>
<td>Level switches</td>
<td>One or two, depending on sensor orientation. Included automatically</td>
</tr>
<tr>
<td></td>
<td>Check valve</td>
<td>Included automatically with order if Vessel option is selected.</td>
</tr>
<tr>
<td>Micro Motion field services</td>
<td></td>
<td>• Site survey</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Startup services</td>
</tr>
</tbody>
</table>

(1) *Not required if you do not need to print bunker tickets.*

Table 1-4: **System requirements: Basic/MID system**

<table>
<thead>
<tr>
<th>Requirement</th>
<th>Component</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Platform</td>
<td>Model 3500 or Model 3700 transmitter:</td>
<td>Not available with the Model 3300 or Model 3350 controller. For ma-</td>
</tr>
<tr>
<td></td>
<td>• 3500<em><strong>3</strong></em>***(F or H)**</td>
<td>rine approvals, Model 3700 required.</td>
</tr>
<tr>
<td></td>
<td>• 3700<em><strong>3</strong></em>***(F or H)**</td>
<td></td>
</tr>
<tr>
<td>Ticket printing</td>
<td>MID-Approved Printer Option (Marine Bunker Instruments)</td>
<td>Includes:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• MID-approved ticket printer</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• MID-approved RS-485 to RS-232 signal converter</td>
</tr>
<tr>
<td>Configuration tool</td>
<td>Local display</td>
<td></td>
</tr>
<tr>
<td></td>
<td>ProLink II v2.94 or higher (optional) (Micro Motion Part PLK*** *)</td>
<td></td>
</tr>
<tr>
<td>Operator interface</td>
<td>Local display</td>
<td></td>
</tr>
<tr>
<td></td>
<td>ProLink II v2.94 or higher (optional) (Micro Motion Part PLK*** *)</td>
<td></td>
</tr>
<tr>
<td>MID calibration for sensor</td>
<td></td>
<td>MID Calibration order option (BB appended to sensor model code).</td>
</tr>
<tr>
<td>Additional devices (Marine Bunker Instruments)</td>
<td>Pressure instrument</td>
<td>Included automatically with order.</td>
</tr>
<tr>
<td></td>
<td>Temperature instrument</td>
<td>Included automatically with order. Used only to correct volume mea-</td>
</tr>
<tr>
<td></td>
<td>Level switches</td>
<td>urements to reference temperature, and not required for MID approval.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>One or two, depending on sensor orientation. Included automatically</td>
</tr>
<tr>
<td></td>
<td></td>
<td>with order.</td>
</tr>
</tbody>
</table>
### Table 1-4: System requirements: Basic/MID system (continued)

<table>
<thead>
<tr>
<th>Requirement</th>
<th>Component</th>
<th>Notes</th>
</tr>
</thead>
</table>
| Micro Motion field services | | • MID-specific site survey  
• MID-specific startup services (include system check and sealing) |

### Table 1-5: System requirements: Profile system

<table>
<thead>
<tr>
<th>Requirement</th>
<th>Component</th>
<th>Notes</th>
</tr>
</thead>
</table>
| Platform | Model 3500 or Model 3700 transmitter:  
• 3500***3****(F or H)**  
• 3700***3****(F or H)** | Not available with the Model 3300 or Model 3350 controller.  
For marine approvals, Model 3700 required. |
| Printing | Profile Printing Option (Marine Bunker Instruments) | Printer Interface Component. Includes:  
• NEMA-approved enclosure  
• Factory-mounted relay and relay power supply |
| | Non–MID-Approved Printer Option (Marine Bunker Instruments)(1) | Includes:  
• Standard ticket printer  
• RS-485 to RS-232 signal converter |
| | PC (customer-supplied)  
ProLink II v2.94 or higher (Micro Motion Part PLK***+)  
RS-485 connection to relay (converter included)  
System printer (customer-supplied) | |
| Configuration tool | Local display  
ProLink II v2.94 or higher (Micro Motion Part PLK***) | |
| Operator interface | Local display  
ProLink II v2.94 or higher (Micro Motion Part PLK***) | |
| Additional devices (Marine Bunker Instruments) | Pressure instrument | Included automatically with order. |
| | Temperature instrument | Included automatically with order.  
Used only to correct volume measurements to reference temperature, and not required for MID approval. |
| | Level switches | One or two, depending on sensor orientation. Included automatically with order. |
Table 1-5: System requirements: Profile system (continued)

<table>
<thead>
<tr>
<th>Requirement</th>
<th>Component</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Check valve</td>
<td></td>
<td>Included automatically with order if Vessel option is selected.</td>
</tr>
<tr>
<td>Micro Motion field services</td>
<td></td>
<td>• Site survey</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Startup services</td>
</tr>
</tbody>
</table>

(1) Not required if you do not need to print bunker tickets.

Table 1-6: System requirements: Profile/MID system

<table>
<thead>
<tr>
<th>Requirement</th>
<th>Component</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Platform</td>
<td>Model 3500 or Model 3700 transmitter:</td>
<td>Not available with the Model 3300 or Model 3350 controller. For marine approvals, Model 3700 required.</td>
</tr>
<tr>
<td></td>
<td>• 3500<em><strong>3</strong></em>** (F or H)**</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• 3700<em><strong>3</strong></em>** (F or H)**</td>
<td></td>
</tr>
<tr>
<td>Printing</td>
<td>Profile Printing Option (Marine Bunker Instruments)</td>
<td>Printer Interface Component. Includes:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• NEMA-approved enclosure</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Factory-mounted relay and relay power supply</td>
</tr>
<tr>
<td></td>
<td>MID-Approved Printer Option (Marine Bunker Instruments)</td>
<td>Includes:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• MID-approved ticket printer</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• MID-approved RS-485 to RS-232 signal converter</td>
</tr>
<tr>
<td></td>
<td>PC (customer-supplied) ProLink II v2.94 or higher (Micro Motion Part PLK***)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>RS-485 connection to relay (converter included) System printer (customer-supplied)</td>
<td></td>
</tr>
<tr>
<td>Configuration tool</td>
<td>Local display ProLink II v2.94 or higher (Micro Motion Part PLK***)</td>
<td></td>
</tr>
<tr>
<td>Operator interface</td>
<td>Local display ProLink II v2.94 or higher (Micro Motion Part PLK***)</td>
<td></td>
</tr>
<tr>
<td>Additional devices (Marine Bunker Instruments)</td>
<td>Pressure instrument</td>
<td>Included automatically with order.</td>
</tr>
<tr>
<td></td>
<td>Temperature instrument</td>
<td>Included automatically with order. Used only to correct volume measurements to reference temperature, and not required for MID approval.</td>
</tr>
</tbody>
</table>
Table 1-6: System requirements: Profile/MID system (continued)

<table>
<thead>
<tr>
<th>Requirement</th>
<th>Component</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Level switches</td>
<td>One or two, depending on sensor orientation. Included automatically with order.</td>
<td></td>
</tr>
<tr>
<td>Check valve</td>
<td>Included automatically with order if Vessel option is selected.</td>
<td></td>
</tr>
<tr>
<td>MID calibration for sensor</td>
<td>MID Calibration order option (BB appended to sensor model code).</td>
<td></td>
</tr>
</tbody>
</table>
| Micro Motion field services        | • MID-specific site survey  
• MID-specific startup services (include system check and sealing) |

1.4 Additional documentation

Table 1-7: Required and recommended documentation for the Certified Marine Bunker Measurement Solution

<table>
<thead>
<tr>
<th>Document</th>
<th>Use</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sensor installation manual</td>
<td>Basic installation instructions for the sensor</td>
<td></td>
</tr>
<tr>
<td>Quick Reference Guide for your Series 3000 transmitter</td>
<td>Basic installation instructions for the transmitter</td>
<td></td>
</tr>
</tbody>
</table>
| Micro Motion Series 3000 MVD Transmitters and Controllers: Configuration and Use Manual | Additional installation information for the transmitter  
General configuration, operation, and maintenance information | Provides information on configuring and operating the Series 3000 transmitter that is not specific to the Marine Bunkering Transfer Package. |
| ProLink II manual                                   | General installation, connection, and operation information         | Provides information on installing ProLink II and connecting to the transmitter. Also provides general information on using the ProLink II interface. |
| Vendor documentation for auxiliary devices          | General installation, configuration, and operation information      |                                                                      |
Install the Series 3000 transmitter with the Marine Bunker Transfer Package

Topics covered in this chapter:

• System options and installation instructions
• Install the Basic system
• Install the Basic/MID system
• Install the Profile system
• Install the Profile/MID system
• Install ferrite beads in transmitter wiring (if required)

2.1 System options and installation instructions

The Series 3000 transmitter with the Marine Bunker Transfer Package is available in four system options. Follow the installation instructions for your system.

2.2 Install the Basic system

This procedure provides installation instructions for a system that measures the bunker delivery and prints bunker tickets. The bunker tickets are not OIML/MID-approved. If you do not need to print bunker tickets, the ticket printer is not required.

Figure 2-1: Schematic of Basic system

Note
Model 3700 transmitter shown. If marine approvals are not required, the Model 3500 transmitter may also be used.
**Prerequisites**

Ensure that the sensor is correctly installed and ready for wiring.

Ensure that the auxiliary devices (level switches, pressure transmitter, and temperature transmitter) are correctly installed and ready for wiring to the Series 3000 transmitter.

Have the following available:

- **Documentation:**
  - Micro Motion Series 3000 MVD Transmitters and Controllers: Configuration and Use Manual
  - The Quick Reference Guide for your transmitter
  - Vendor documentation for all components

- **Cable:**
  - Power cable
  - Standard twisted-pair shielded signal cable

Locate all components to meet the following requirements:

- The maximum distance between the sensor and the core processor is 60 feet (20 meters). In a typical installation, the core processor is mounted directly on the sensor.
- The maximum distance between the core processor and the transmitter is 1000 feet (300 meters).
- The maximum length of an RS-485 connection is 3600 feet (1000 meters) at 9600 baud.
- The maximum length of an RS-232 connection is 15 feet (5 meters).
- The ticket printer and signal converter must be installed in a safe area.

Review power requirements for all components and ensure that you will be able to supply enough power.

---

**Important**

For marine approvals (available only with the Model 3700 transmitter, and only if the Marine Approvals option was ordered), additional requirements apply to the following:

- Wiring between the sensor and the transmitter
- Transmitter I/O wiring
- Transmitter power wiring

See Section 2.6 and incorporate the additional steps into your installation tasks.

---

**Important**

During installation, refer to the appropriate integrated wiring diagram. See Section A.1:

- For sensors mounted in a vertical pipe (Flag orientation), see page 84.
- For sensors mounted in a horizontal pipe (Tubes-down orientation), see page 86.
Procedure

1. Follow the instructions in *Micro Motion Series 3000 MVD Transmitters and Controllers: Configuration and Use Manual* and the appropriate Quick Reference Guide to perform the following installation tasks:
   a. Mount the transmitter.
   b. Wire the transmitter to the sensor.
   c. Wire the transmitter’s secondary mA output and frequency output (if they will be used).
   d. Wire power to the transmitter.
   e. Ground the transmitter.

2. Wire the level switch (or switches) to Discrete Input 1 and to power.
   When Discrete Input 1 is assigned to Start/Stop Totalizers (during configuration), it will start totalizers when there is liquid in the pipeline, and stop totalizers when there is no liquid in the pipeline.

3. (Optional) Set up an integrity detection loop and wire it to Discrete Input 2.
   The integrity detection loop may be used to detect leaks, cable breakage, short circuits, and so on. Any preferred method or device can be used.

4. Set up a HART loop that connects the primary mA output to the external pressure transmitter and the external temperature transmitter.

Notes

- The temperature transmitter is used only to correct volume measurements to reference temperature. It may not be required in your installation.
- The Field Communicator can be connected to this loop.

5. (Optional) Follow the instructions in *Micro Motion Series 3000 MVD Transmitters and Controllers: Configuration and Use Manual* to wire Discrete Output 1 and Discrete Output 2 to signal devices such as lights or horns.

Tip

When the Marine Bunker Transfer Package is installed, a special default configuration is implemented for Discrete Output 1, Discrete Output 2, Discrete Event 1, and Discrete Event 2:

- Discrete Event 1 is activated if *Aeration Limit* reaches 20% (medium aeration).
- Discrete Event 2 is activated if *Aeration Limit* reaches 75% (high aeration).
- Discrete Output 1 is assigned to Discrete Event 1.
- Discrete Output 2 is assigned to Discrete Event 2.

If this default configuration is retained and Discrete Output 1 and Discrete Output 2 are wired to signal devices, the signal devices will alert the operator if *Aeration Limit* reaches the 20% or 75% threshold. You can change the thresholds defined for medium and high aeration by changing the HI PV values for Discrete Event 1 and Discrete Event 2.
6. (Optional) Follow the instructions in *Micro Motion Series 3000 MVD Transmitters and Controllers: Configuration and Use Manual* and the appropriate Quick Reference Guide to wire Discrete Output 3 as desired.

7. Install the ticket printer.
   a. Connect the printer to power according to the instructions in the vendor documentation.
   b. Set the DIP switches on the printer as shown in the following table.

**Table 2-1: DIP switch settings for Epson TM-U295 printer**

<table>
<thead>
<tr>
<th>DIP switch</th>
<th>Setting</th>
<th>Printer communication parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>OFF</td>
<td>Baud: 9600</td>
</tr>
<tr>
<td>2</td>
<td>OFF</td>
<td>Parity: Even</td>
</tr>
<tr>
<td>3</td>
<td>OFF</td>
<td>Data bits: 8</td>
</tr>
<tr>
<td>4</td>
<td>OFF</td>
<td>Stop bits: 1</td>
</tr>
<tr>
<td>5</td>
<td>ON</td>
<td>Characters per second: 32</td>
</tr>
<tr>
<td>6</td>
<td>ON</td>
<td>Buffer size: 512</td>
</tr>
<tr>
<td>7</td>
<td>OFF</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>OFF</td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>OFF</td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>OFF</td>
<td></td>
</tr>
</tbody>
</table>

   c. Attach the adapter to the signal converter.

   An RS-485 to RS-232 signal converter and a DB9 to DB25 adapter were supplied with the system.

   d. Plug the adapter into the terminal block on the printer.

   e. Connect the RS-485 terminals on the signal converter to the RS-485 terminals on the transmitter.

**Table 2-2: RS-485 connections between signal converter and transmitter**

<table>
<thead>
<tr>
<th>RS-485 terminal</th>
<th>Signal converter terminals</th>
<th>Transmitter terminals</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td><strong>Model 3700</strong></td>
</tr>
<tr>
<td>RS-485/A</td>
<td>Terminal 1</td>
<td>12</td>
</tr>
<tr>
<td>RS-485/B</td>
<td>Terminal 2</td>
<td>11</td>
</tr>
</tbody>
</table>
2.3 Install the Basic/MID system

This procedure provides installation instructions for a system that measures the bunker delivery and prints bunker tickets. The bunker tickets are OIML/MID-approved.

Figure 2-2: Schematic of Basic/MID system

Note
Model 3700 transmitter shown. If marine approvals are not required, the Model 3500 transmitter may also be used.

Prerequisites

Ensure that the sensor is correctly installed and ready for wiring.

Ensure that the auxiliary devices (level switches, pressure transmitter, and temperature transmitter) are correctly installed and ready for wiring to the Series 3000 transmitter.

Have the following available:

- Documentation:
  - Micro Motion Series 3000 MVD Transmitters and Controllers: Configuration and Use Manual
  - The Quick Reference Guide for your transmitter
  - Vendor documentation for all components
- Cable:
  - Power cable
  - Standard twisted-pair shielded signal cable

Locate all components to meet the following requirements:

- The maximum distance between the sensor and the core processor is 60 feet (20 meters). In a typical installation, the core processor is mounted directly on the sensor.
- The maximum distance between the core processor and the transmitter is 1000 feet (300 meters).
- The maximum length of an RS-485 connection is 3600 feet (1000 meters) at 9600 baud.
• The maximum length of an RS-232 connection is 15 feet (5 meters).
• The ticket printer and signal converter must be installed in a safe area.

Review power requirements for all components and ensure that you will be able to supply enough power.

**Important**
For marine approvals (available only with the Model 3700 transmitter, and only if the Marine Approvals option was ordered), additional requirements apply to the following:

• Wiring between the sensor and the transmitter
• Transmitter I/O wiring
• Transmitter power wiring

See **Section 2.6** and incorporate the additional steps into your installation tasks.

**Important**
During installation, refer to the appropriate integrated wiring diagram. See **Section A.2**:  
• For sensors mounted in a vertical pipe (Flag orientation), see page 89.
• For sensors mounted in a horizontal pipe (Tubes-down orientation), see page 91.

**Procedure**

1. Follow the instructions in *Micro Motion Series 3000 MVD Transmitters and Controllers: Configuration and Use Manual* and the appropriate Quick Reference Guide to perform the following installation tasks:

   a. Mount the transmitter.
   b. Wire the transmitter to the sensor.
   c. Wire the transmitter's secondary mA output and frequency output (if they will be used).
   d. Wire power to the transmitter.
   e. Ground the transmitter.

2. Wire the level switch (or switches) to Discrete Input 1 and to power.

   When Discrete Input 1 is assigned to Start/Stop Totalizers (during configuration), it will start totalizers when there is liquid in the pipeline, and stop totalizers when there is no liquid in the pipeline.

3. (Optional) Set up an integrity detection loop and wire it to Discrete Input 2.

   The integrity detection loop may be used to detect leaks, cable breakage, short circuits, and so on. Any preferred method or device can be used.

4. Set up a HART loop that connects the primary mA output to the external pressure transmitter and the external temperature transmitter.
Notes

• The temperature transmitter is used only to correct volume measurements to reference temperature. It may not be required in your installation.
• The Field Communicator can be connected to this loop.

5. (Optional) Follow the instructions in *Micro Motion Series 3000 MVD Transmitters and Controllers: Configuration and Use Manual* to wire Discrete Output 1 and Discrete Output 2 to signal devices such as lights or horns.

Tip
When the Marine Bunker Transfer Package is installed, a special default configuration is implemented for Discrete Output 1, Discrete Output 2, Discrete Event 1, and Discrete Event 2:
• Discrete Event 1 is activated if *Aeration Limit* reaches 20% (medium aeration).
• Discrete Event 2 is activated if *Aeration Limit* reaches 75% (high aeration).
• Discrete Output 1 is assigned to Discrete Event 1.
• Discrete Output 2 is assigned to Discrete Event 2.

If this default configuration is retained and Discrete Output 1 and Discrete Output 2 are wired to signal devices, the signal devices will alert the operator if *Aeration Limit* reaches the 20% or 75% threshold. You can change the thresholds defined for medium and high aeration by changing the HI PV values for Discrete Event 1 and Discrete Event 2.

6. (Optional) Follow the instructions in *Micro Motion Series 3000 MVD Transmitters and Controllers: Configuration and Use Manual* and the appropriate Quick Reference Guide to wire Discrete Output 3 as desired.

7. Install the ticket printer.

   a. Connect the printer to power according to the instructions in the vendor documentation.
   b. Set the DIP switches on the printer as shown in the following table.

⚠️ CAUTION!

The DIP switches are on the bottom of the printer, under the DIP switch cover. Power down the printer before removing the DIP switch cover.

Table 2-3: DIP switch settings for Epson TM-T88V printer

<table>
<thead>
<tr>
<th>Switch bank</th>
<th>DIP switch settings</th>
<th>Printer communication parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>DSW1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Switch 1-1</td>
<td>OFF</td>
<td>Baud: 38400</td>
</tr>
<tr>
<td>Switch 1-2</td>
<td>OFF</td>
<td>Parity: Even</td>
</tr>
<tr>
<td>Switch 1-3</td>
<td>OFF</td>
<td>Data bits: 8</td>
</tr>
<tr>
<td>Switch 1-4</td>
<td>OFF</td>
<td>Stop bits: 1</td>
</tr>
<tr>
<td>Switch 1-5</td>
<td>ON</td>
<td>Characters per second: 400</td>
</tr>
<tr>
<td>Switch 1-6</td>
<td>ON</td>
<td>Buffer size: 1024</td>
</tr>
</tbody>
</table>
Table 2-3: DIP switch settings for Epson TM-T88V printer (continued)

<table>
<thead>
<tr>
<th>Switch bank</th>
<th>DIP switch settings</th>
<th>Printer communication parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>Switch 1-7</td>
<td>ON</td>
<td></td>
</tr>
<tr>
<td>Switch 1-8</td>
<td>ON</td>
<td></td>
</tr>
<tr>
<td>DSW2</td>
<td>Switch 2-1</td>
<td>OFF</td>
</tr>
<tr>
<td></td>
<td>Switches 2-2 through 2-8</td>
<td>As desired</td>
</tr>
</tbody>
</table>

c. Attach the adapter to the signal converter.

An RS-485 to RS-232 signal converter and a DB9 to DB25 adapter were supplied with the system.
d. Plug the adapter into the terminal block on the printer.
e. Connect the RS-485 terminals on the signal converter to the RS-485 terminals on the transmitter as shown in the following table.

Table 2-4: RS-485 connections between signal converter and transmitter

<table>
<thead>
<tr>
<th>RS-485 terminal</th>
<th>Signal converter terminals</th>
<th>Transmitter terminals</th>
<th>Transmitter terminals</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Model 3700</td>
<td>Model 3500 with screw-type or solder terminals</td>
<td>Model 3500 with I/O cables</td>
</tr>
<tr>
<td>RS-485/A</td>
<td>Terminal 1</td>
<td>12</td>
<td>a32</td>
</tr>
<tr>
<td>RS-485/B</td>
<td>Terminal 2</td>
<td>11</td>
<td>c32</td>
</tr>
</tbody>
</table>

2.4 Install the Profile system

This procedure provides installation instructions for a system that measures the bunker delivery and prints bunker tickets and profile reports. The bunker tickets are not OIML/MID-approved. The profile report is not OIML/MID-approved. If you do not need to print bunker tickets, the ticket printer is not required.
Figure 2-3: Schematic of Profile system

Note
Model 3700 transmitter shown. If marine approvals are not required, the Model 3500 transmitter may also be used.

Prerequisites

Ensure that the sensor is correctly installed and ready for wiring.

Ensure that the auxiliary devices (level switches, pressure transmitter, and temperature transmitter) are correctly installed and ready for wiring to the Series 3000 transmitter.

Ensure that ProLink II v2.94 is installed on the PC you will use for bunkering, and that you have the appropriate ProLink II installation kit.

Have the following available:

- Documentation:
  - Micro Motion Series 3000 MVD Transmitters and Controllers: Configuration and Use Manual
  - The Quick Reference Guide for your transmitter
  - Vendor documentation for all components

- Cable:
  - Power cable
  - Standard twisted-pair shielded signal cable

Locate all components to meet the following requirements:
The maximum distance between the sensor and the core processor is 60 feet (20 meters). In a typical installation, the core processor is mounted directly on the sensor.

The maximum distance between the core processor and the transmitter is 1000 feet (300 meters).

The maximum length of an RS-485 connection is 3600 feet (1000 meters) at 9600 baud.

The maximum length of an RS-232 connection is 15 feet (5 meters).

The Printer Interface Component must be installed in a safe area.

The ticket printer and signal converter must be installed in a safe area.

The PC and system printer must be installed in a safe area.

Review power requirements for all components and ensure that you will be able to supply enough power.

**Important**

For marine approvals (available only with the Model 3700 transmitter, and only if the Marine Approvals option was ordered), additional requirements apply to the following:

- Wiring between the sensor and the transmitter
- Transmitter I/O wiring
- Transmitter power wiring

See Section 2.6 and incorporate the additional steps into your installation tasks.

---

**Important**

During installation, refer to the appropriate integrated wiring diagram. See Section A.3:

- For sensors mounted in a vertical pipe (Flag orientation), see page 94.
- For sensors mounted in a horizontal pipe (Tubes-down orientation), see page 96.

**Procedure**

1. Follow the instructions in Micro Motion Series 3000 MVD Transmitters and Controllers: Configuration and Use Manual and the appropriate Quick Reference Guide to perform the following installation tasks:
   a. Mount the transmitter.
   b. Wire the transmitter to the sensor.
   c. Wire the transmitter’s secondary mA output and frequency output (if they will be used).
   d. Wire power to the transmitter.
   e. Ground the transmitter.

2. Mount the Printer Interface Component to any flat surface. See the following figure for mounting dimensions.
3. Wire the level switch (or switches) to Discrete Input 1 and to power.

When Discrete Input 1 is assigned to Start/Stop Totalizers (during configuration), it will start totalizers when there is liquid in the pipeline, and stop totalizers when there is no liquid in the pipeline.

4. (Optional) Set up an integrity detection loop and wire it to Discrete Input 2.

The integrity detection loop may be used to detect leaks, cable breakage, short circuits, and so on. Any preferred method or device can be used.

5. Set up a HART loop that connects the primary mA output to the external pressure transmitter and the external temperature transmitter.

Notes
- The temperature transmitter is used only to correct volume measurements to reference temperature. It may not be required in your installation.
- The Field Communicator can be connected to this loop.

6. (Optional) Follow the instructions in Micro Motion Series 3000 MVD Transmitters and Controllers: Configuration and Use Manual to wire Discrete Output 1 and Discrete Output 2 to signal devices such as lights or horns.
Tip
When the Marine Bunker Transfer Package is installed, a special default configuration is implemented for Discrete Output 1, Discrete Output 2, Discrete Event 1, and Discrete Event 2:

- Discrete Event 1 is activated if Aeration Limit reaches 20% (medium aeration).
- Discrete Event 2 is activated if Aeration Limit reaches 75% (high aeration).
- Discrete Output 1 is assigned to Discrete Event 1.
- Discrete Output 2 is assigned to Discrete Event 2.

If this default configuration is retained and Discrete Output 1 and Discrete Output 2 are wired to signal devices, the signal devices will alert the operator if Aeration Limit reaches the 20% or 75% threshold. You can change the thresholds defined for medium and high aeration by changing the HI PV values for Discrete Event 1 and Discrete Event 2.

7. Install the ticket printer.
   a. Connect the printer to power according to the instructions in the vendor documentation.
   b. Set the DIP switches on the printer as shown in the following table.

   Table 2-5: DIP switch settings for Epson TM-U295 printer

<table>
<thead>
<tr>
<th>DIP switch</th>
<th>Setting</th>
<th>Printer communication parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>OFF</td>
<td>Baud: 9600</td>
</tr>
<tr>
<td>2</td>
<td>OFF</td>
<td>Parity: Even</td>
</tr>
<tr>
<td>3</td>
<td>OFF</td>
<td>Data bits: 8</td>
</tr>
<tr>
<td>4</td>
<td>OFF</td>
<td>Stop bits: 1</td>
</tr>
<tr>
<td>5</td>
<td>ON</td>
<td>Characters per second: 32</td>
</tr>
<tr>
<td>6</td>
<td>ON</td>
<td>Buffer size: 128</td>
</tr>
<tr>
<td>7</td>
<td>OFF</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>OFF</td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>OFF</td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>OFF</td>
<td></td>
</tr>
</tbody>
</table>

   c. Attach the adapter to the signal converter.
      An RS-485 to RS-232 signal converter and a DB9 to DB25 adapter were supplied with the system.
   d. Plug the adapter into the terminal block on the printer.

8. Wire the Printer Interface Component.
   a. Open the Printer Interface Component.
   b. Wire power to the relay power supply according to the instructions in the vendor documentation.
   c. Wire the relay to Discrete Output 3 on the transmitter.
d. Wire one set of RS-485 terminals on the relay to the RS-485 terminals on the transmitter.

Table 2-6: RS-485 connections between transmitter and relay

<table>
<thead>
<tr>
<th>RS-485 terminal</th>
<th>Relay terminals</th>
<th>Transmitter terminals</th>
<th>Model 3700</th>
<th>Model 3500 with screw-type or solder terminals</th>
<th>Model 3500 with I/O cables</th>
</tr>
</thead>
<tbody>
<tr>
<td>RS-485/A</td>
<td>Terminal 21</td>
<td></td>
<td>12</td>
<td>a32</td>
<td>25</td>
</tr>
<tr>
<td>RS-485/B</td>
<td>Terminal 11</td>
<td></td>
<td>11</td>
<td>c32</td>
<td>24</td>
</tr>
</tbody>
</table>

e. Wire one set of RS-485 terminals on the relay to the RS-485 terminals on the signal converter.

Table 2-7: RS-485 connections between signal converter and relay

<table>
<thead>
<tr>
<th>RS-485 terminal</th>
<th>Relay terminals</th>
<th>Signal converter terminals</th>
</tr>
</thead>
<tbody>
<tr>
<td>RS-485/A</td>
<td>24</td>
<td>Terminal 1</td>
</tr>
<tr>
<td>RS-485/B</td>
<td>14</td>
<td>Terminal 2</td>
</tr>
</tbody>
</table>

f. Close the Printer Interface Component.

9. Ensure that the PC is connected to the printer that you will use to print the profile report, and that this printer is defined as the default printer.

2.5 Install the Profile/MID system

This procedure provides installation instructions for a system that measures the bunker delivery and prints bunker tickets and profile reports. The bunker tickets are OIML/MID-approved. The profile reports are not OIML/MID-approved.
Figure 2-5: Schematic of Profile/MID system

Prerequisites

Ensure that the sensor is correctly installed and ready for wiring.

Ensure that the auxiliary devices (level switches, pressure transmitter, and temperature transmitter) are correctly installed and ready for wiring to the Series 3000 transmitter.

Ensure that ProLink II v2.94 is installed on the PC you will use for bunkering, and that you have the appropriate ProLink II installation kit.

Have the following available:

- Documentation:
  - Micro Motion Series 3000 MVD Transmitters and Controllers: Configuration and Use Manual
  - The Quick Reference Guide for your transmitter
  - Vendor documentation for all components

- Cable:
  - Power cable
  - Standard twisted-pair shielded signal cable

Locate all components to meet the following requirements:

Note

Model 3700 transmitter shown. If marine approvals are not required, the Model 3500 transmitter may also be used.
- The maximum distance between the sensor and the core processor is 60 feet (20 meters). In a typical installation, the core processor is mounted directly on the sensor.
- The maximum distance between the core processor and the transmitter is 1000 feet (300 meters).
- The maximum length of an RS-485 connection is 3600 feet (1000 meters) at 9600 baud.
- The maximum length of an RS-232 connection is 15 feet (5 meters).
- The Printer Interface Component must be installed in a safe area.
- The ticket printer and signal converter must be installed in a safe area.
- The PC and system printer must be installed in a safe area.

Review power requirements for all components and ensure that you will be able to supply enough power.

**Important**

For marine approvals (available only with the Model 3700 transmitter, and only if the Marine Approvals option was ordered), additional requirements apply to the following:

- Wiring between the sensor and the transmitter
- Transmitter I/O wiring
- Transmitter power wiring

See *Section 2.6* and incorporate the additional steps into your installation tasks.

**Important**

During installation, refer to the appropriate integrated wiring diagram. See *Section A.4*:

- For sensors mounted in a vertical pipe (Flag orientation), see page 99.
- For sensors mounted in a horizontal pipe (Tubes-down orientation), see page 101.

**Procedure**

1. Follow the instructions in *Micro Motion Series 3000 MVD Transmitters and Controllers: Configuration and Use Manual* and the appropriate Quick Reference Guide to perform the following installation tasks:
   a. Mount the transmitter.
   b. Wire the transmitter to the sensor.
   c. Wire the transmitter’s secondary mA output and frequency output (if they will be used).
   d. Wire power to the transmitter.
   e. Ground the transmitter.
2. Mount the Printer Interface Component to any flat surface. See the following figure for mounting dimensions.
3. Wire the level switch (or switches) to Discrete Input 1 and to power.

When Discrete Input 1 is assigned to Start/Stop Totalizers (during configuration), it will start totalizers when there is liquid in the pipeline, and stop totalizers when there is no liquid in the pipeline.

4. (Optional) Set up an integrity detection loop and wire it to Discrete Input 2.

The integrity detection loop may be used to detect leaks, cable breakage, short circuits, and so on. Any preferred method or device can be used.

5. Set up a HART loop that connects the primary mA output to the external pressure transmitter and the external temperature transmitter.

Notes

- The temperature transmitter is used only to correct volume measurements to reference temperature. It may not be required in your installation.
- The Field Communicator can be connected to this loop.

6. (Optional) Follow the instructions in Micro Motion Series 3000 MVD Transmitters and Controllers: Configuration and Use Manual to wire Discrete Output 1 and Discrete Output 2 to signal devices such as lights or horns.
Tip
When the Marine Bunker Transfer Package is installed, a special default configuration is implemented for Discrete Output 1, Discrete Output 2, Discrete Event 1, and Discrete Event 2:

- Discrete Event 1 is activated if Aeration Limit reaches 20% (medium aeration).
- Discrete Event 2 is activated if Aeration Limit reaches 75% (high aeration).
- Discrete Output 1 is assigned to Discrete Event 1.
- Discrete Output 2 is assigned to Discrete Event 2.

If this default configuration is retained and Discrete Output 1 and Discrete Output 2 are wired to signal devices, the signal devices will alert the operator if Aeration Limit reaches the 20% or 75% threshold. You can change the thresholds defined for medium and high aeration by changing the HI PV values for Discrete Event 1 and Discrete Event 2.

7. Install the ticket printer.
   a. Connect the printer to power according to the instructions in the vendor documentation.
   b. Set the DIP switches on the printer as shown in the following table.

⚠️ CAUTION!
The DIP switches are on the bottom of the printer, under the DIP switch cover. Power down the printer before removing the DIP switch cover.

Table 2-8: DIP switch settings for Epson TM-T88V printer

<table>
<thead>
<tr>
<th>Switch bank</th>
<th>DIP switch settings</th>
<th>Printer communication parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>DSW1</td>
<td>Switch 1-1 OFF</td>
<td>Baud: 38400</td>
</tr>
<tr>
<td></td>
<td>Switch 1-2 OFF</td>
<td>Parity: Even</td>
</tr>
<tr>
<td></td>
<td>Switch 1-3 OFF</td>
<td>Data bits: 8</td>
</tr>
<tr>
<td></td>
<td>Switch 1-4 OFF</td>
<td>Stop bits: 1</td>
</tr>
<tr>
<td></td>
<td>Switch 1-5 ON</td>
<td>Characters per second: 400</td>
</tr>
<tr>
<td></td>
<td>Switch 1-6 ON</td>
<td>Buffer size: 1024</td>
</tr>
<tr>
<td></td>
<td>Switch 1-7 ON</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Switch 1-8 ON</td>
<td></td>
</tr>
<tr>
<td>DSW2</td>
<td>Switch 2-1 OFF</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Switches 2-2 through 2-8</td>
<td>As desired</td>
</tr>
</tbody>
</table>

   c. Attach the adapter to the signal converter.

   An RS-485 to RS-232 signal converter and a DB9 to DB25 adapter were supplied with the system.
   d. Plug the adapter into the terminal block on the printer.
8. Wire the Printer Interface Component.
   a. Open the Printer Interface Component.
   b. Wire power to the relay power supply according to the instructions in the vendor documentation.
   c. Wire the relay to Discrete Output 3 on the transmitter.
   d. Wire one set of RS-485 terminals on the relay to the RS-485 terminals on the transmitter.

<table>
<thead>
<tr>
<th>RS-485 terminal</th>
<th>Relay terminals</th>
<th>Model 3700</th>
<th>Model 3500 with screw-type or solder terminals</th>
<th>Model 3500 with I/O cables</th>
</tr>
</thead>
<tbody>
<tr>
<td>RS-485/A</td>
<td>Terminal 21</td>
<td>12</td>
<td>a32</td>
<td>25</td>
</tr>
<tr>
<td>RS-485/B</td>
<td>Terminal 11</td>
<td>11</td>
<td>c32</td>
<td>24</td>
</tr>
</tbody>
</table>

e. Wire one set of RS-485 terminals on the relay to the RS-485 terminals on the signal converter.

<table>
<thead>
<tr>
<th>RS-485 terminal</th>
<th>Relay terminals</th>
<th>Signal converter terminals</th>
</tr>
</thead>
<tbody>
<tr>
<td>RS-485/A</td>
<td>24</td>
<td>Terminal 1</td>
</tr>
<tr>
<td>RS-485/B</td>
<td>14</td>
<td>Terminal 2</td>
</tr>
</tbody>
</table>

f. Close the Printer Interface Component.

9. Ensure that the PC is connected to the printer that you will use to print the profile report, and that this printer is defined as the default printer.

### 2.6 Install ferrite beads in transmitter wiring (if required)

To comply with the RF (radio frequency) emissions limits specified in IACS E10 and Lloyd's Register Test Specification Number 1 (2002), ferrite beads must be installed on all cables connected to the Model 3700 transmitter. If the Marine Approvals option is ordered, Micro Motion supplies a set of ferrite beads to be used for this purpose.

**Restriction**

This requirement applies only to installations that require marine approvals [i.e., Lloyd's Register, Bureau Veritas (BV), Det Norske Veritas (DNV), American Bureau of Shipping (ABS)]. For these installations, the Model 3700 transmitter is required.
**Prerequisites**

- The set of four ferrite beads supplied with the Marine Approvals option: three small beads and one large bead
- Heat shrink (optional)

**Procedure**

1. When wiring the transmitter to the sensor, loop all four wires through the large ferrite bead, and repeat, so that the wires form two complete loops around the bead. Position the bead close to the conduit openings on the transmitter, while leaving some slack in the wires.

   **Figure 2-7: Large ferrite bead in sensor-to-transmitter wiring**

2. When wiring the transmitter to the power supply, loop all wires (two or three, depending on installation) through one of the small ferrite beads, so that the wires form one complete loop around the bead. Position the bead close to the conduit openings on the transmitter, while leaving some slack in the wires.

   **Figure 2-8: Small ferrite bead in power wiring**

3. When wiring the transmitter to inputs and outputs, pass the I/O wires through one of the small ferrite beads. You may use one or two beads, as convenient. Position the bead close to the conduit openings on the transmitter, while leaving some slack in the wires.

**Tip**
Micro Motion recommends looping the I/O wires, but loops are not required in this location.
4. (Optional) Apply heat shrink to stabilize the wires in the beads.
5. Tuck the beads and wires into the available space inside the transmitter wiring compartment.

**Figure 2-9: Small ferrite beads in I/O wiring**

**Figure 2-10: Ferrite beads in transmitter wiring compartment**
3 Start up the system

Topics covered in this chapter:

• Power up the system
• Perform optional startup tasks

3.1 Power up the system

You must power up the transmitter, the ticket printer, and the relay power supply in the Printer Interface Component (when applicable).

1. Follow the instructions in Micro Motion Series 3000 MVD Transmitters and Controllers: Configuration and Use Manual to power up the transmitter.

   After the standard start-up sequence, the transmitter displays the Marine Bunkering dashboard. The Security Breach banner is displayed at the top of the screen.

2. Follow the instructions in the vendor documentation to power up the ticket printer.

3. (Optional) Power up the relay power supply in the Printer Interface Component.

3.1.1 Marine Bunkering dashboard at system startup

The Marine Bunkering dashboard contains the display menus and controls that are used to configure the bunker ticket, perform a bunker transfer, and print the bunker ticket.

Options on the Marine Bunkering dashboard at system startup

If the Marine Bunker Transfer Package is installed, the transmitter automatically displays the Marine Bunkering dashboard when the system is first powered up.

The Marine Bunkering dashboard offers the following menu options:

• Bunker Operations
• Bunker Ticket Log (not displayed until a bunker transfer has been performed)
• Format Ticket

Exiting and returning to the Marine Bunkering dashboard

To access other areas of the display and menu system from the Marine Bunkering dashboard:

• Press the Exit button to access the View menu.
• Press the Security button to access the Management menu.
3.2 Perform optional startup tasks

Zeroing the flowmeter can be used to adjust measurement to local conditions. Testing the inputs and outputs ensures that signals are being sent and received. Trimming the mA outputs calibrates the mA output to the mA receiving device.

**Tip**
In most cases, these tasks will be performed by the service technician who performs the system startup.

**Prerequisites**
To perform these tasks, the transmitter must be unsecured.

**Important**
If you send the transmitter to a calibration facility to perform a water calibration, either during startup or any time thereafter, LD Optimization must be disabled. To do this: Navigate to the Management menu, then select Configuration > Inputs > Core Processor > Sensor Cal Data. Scroll to LD Optimization and disable the feature (change Yes to No). When you have completed the calibration, re-enable LD Optimization.

**Procedure**

1. At the transmitter, navigate to the Management menu.

   **Tip**
   If you are at the Marine Bunkering dashboard, press the Security button.

2. Follow the instructions in *Micro Motion Series 3000 MVD Transmitters and Controllers: Configuration and Use Manual* to perform these tasks, if appropriate.
   
   a. Zero the flowmeter.
   
   b. Perform loop tests on the mA outputs, frequency output, discrete outputs, and discrete inputs.
   
   c. Trim the mA outputs.

3. Press the Exit button to return to the Marine Bunkering dashboard.
4 Configure the system using the transmitter display

Topics covered in this chapter:

- Configure auxiliary devices
- Configure basic flowmeter parameters
- Configure bunker ticket options using the transmitter display
- Configure communications
- Secure and seal the transmitter

Tip
In most cases, these tasks will be performed by the service technician who performs the system startup.

4.1 Configure auxiliary devices

The pressure transmitter, temperature transmitter, level switches, and integrity detection devices (if present) must be configured for use by the Series 3000 transmitter.

1. At the pressure transmitter:
   a. Define a HART tag for polling.
   b. Set the pressure unit to the unit to be used by the Series 3000 transmitter.

2. At the temperature transmitter:
   a. Define a HART tag for polling.
   b. Set the temperature unit to the unit to be used by the Series 3000 transmitter.

3. At the level switch (or switches):
   a. Set Mode Switch to Wet On.
   b. Set Switching Time Delay to 0.3 seconds.

4. (Optional) If your installation includes an integrity detection loop, configure the integrity detection devices as required to report leakage, broken cables, short circuits, or other malfunction.
4.2 Configure basic flowmeter parameters

Basic flowmeter parameters include the parameters that are part of standard transmitter configuration. Some parameters are configured automatically by the Marine Bunker Transfer Package. Some parameters are not applicable to systems with the Marine Bunker Transfer Package. You can configure the remaining parameters as appropriate for your installation.

Prerequisites

Refer to *Micro Motion Series 3000 MVD Transmitters and Controllers: Configuration and Use Manual* for detailed configuration instructions and access to menus.

To configure the transmitter, the transmitter must be unsecured.

When the Marine Bunker Transfer Package is installed, certain parameters are set specifically for marine bunkering installations (see Section 4.2.1). All other parameters are set to the transmitter defaults.

Procedure

1. At the transmitter, navigate to the Management menu.

   **Tip**
   If you are at the Marine Bunkering dashboard, press the Security button.

2. Configure security and language.

   a. Configure the maintenance and configuration passwords, and enable or disable them as desired.
   b. Configure the language used on the display.

   **Restriction**
   The language selection does not apply to the Marine Bunker Transfer Package menus and displays. English is used for all Marine Bunker Transfer Package screens.

   c. Do not configure the Weights & Measures application.
   d. Do not enable write-protection.

3. Configure system data and alarm severity.

4. Enable core processor inputs.

5. Configure process variables as desired.

6. Configure sensor calibration data and sensor information for your sensor.

7. Set Flow Direction.
### Option Description

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Forward Only</td>
<td>Bunker transfers will be measured in one direction only: either loading or unloading. The Flow Direction arrow on the sensor matches the direction of flow.</td>
</tr>
<tr>
<td>Negate Forward Only</td>
<td>Bunker transfers will be measured in one direction only: either loading or unloading. The Flow Direction arrow on the sensor is opposite to the direction of flow.</td>
</tr>
<tr>
<td>Bi-Directional</td>
<td>Bunker transfers will be measured in two directions: both loading and unloading.</td>
</tr>
</tbody>
</table>

**Tip**
Forward Only and Negate Forward Only are typically used by shore facilities and vessels. Bi-Directional is used only by barges.

**Important**
If you set Flow Direction to Bi-Directional, ensure that the Mass Total value shown at the beginning of each transfer is 0.0. If it is not, contact Micro Motion.

8. Configure Discrete Input 1 for use with the level switch or switches.
   a. Set Discrete Input 1 Polarity to Active Low.
   b. Assign Start/Stop Totalizers to Discrete Input 1.

   If the system is wired as recommended, totalizers will start when liquid is detected in the pipeline, and stop when no liquid is detected.

9. (Optional) Configure Discrete Input 2 for use in the integrity detection loop, if present in your installation.
   a. Set Discrete Input 2 Polarity as required by the integrity detection device and the wiring.
   b. Assign Integrity Breach to Discrete Input 2.

   The transmitter will post Alarm 133: Integrity Detection if a problem with flow or wiring is detected.

10. (Optional) Configure Discrete Events 3, 4, and 5.

11. Configure polling for temperature.
    Set External Tag to the tag defined at the temperature device.

12. Configure polling for pressure.
    Set External Tag to the tag defined at the pressure device.

13. Configure other input parameters as desired.

a. If Discrete Output 3 is wired to a relay to enable printing both bunker tickets and profile reports (Profile or Profile/MID systems), set the source variable to RS485 Dual Function.

b. Configure all other outputs as desired.

**Tip**
When the Marine Bunker Transfer Package is installed, a special default configuration is implemented for Discrete Output 1, Discrete Output 2, Discrete Event 1, and Discrete Event 2:

- Discrete Event 1 is activated if Aeration Limit reaches 20% (medium aeration).
- Discrete Event 2 is activated if Aeration Limit reaches 75% (high aeration).
- Discrete Output 1 is assigned to Discrete Event 1.
- Discrete Output 2 is assigned to Discrete Event 2.

If this default configuration is retained and Discrete Output 1 and Discrete Output 2 are wired to signal devices, the signal devices will alert the operator if Aeration Limit reaches the 20% or 75% threshold. You can change the thresholds defined for medium and high aeration by changing the HI PV values for Discrete Event 1 and Discrete Event 2.

15. (Optional) Follow the instructions in Micro Motion Series 3000 MVD Transmitters and Controllers: Configuration and Use Manual to configure the process monitor.

**Tip**
You can configure Aeration Limit as a display variable. Use this approach if you want to monitor Aeration Limit along with other variables that are not on the Marine Bunkering dashboard.

16. Press the Exit button to return to the Marine Bunkering dashboard.

### 4.2.1 Default parameter settings for the Marine Bunker Transfer Package

When the Marine Bunker Transfer Package is installed, the default values for certain parameters are different from the standard transmitter defaults.

Parameters that have different default values are listed in the following table. All other parameters have the standard defaults.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default values set by Marine Bunker Transfer Package</th>
<th>User configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mass Flow Cutoff</td>
<td>8 tonnes/hr to 36 tonnes/hr, depending on sensor</td>
<td>As desired.</td>
</tr>
<tr>
<td>Mass Flow Measurement Unit</td>
<td>metric tonnes per hour</td>
<td>As desired.</td>
</tr>
<tr>
<td>Volume Flow Type</td>
<td>Liquid</td>
<td>As desired.</td>
</tr>
<tr>
<td>Volume Flow Measurement Unit</td>
<td>m3/hr</td>
<td>As desired.</td>
</tr>
</tbody>
</table>
Table 4-1: Parameters for Marine Bunker Transfer Package (continued)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default values set by Marine Bunker Transfer Package</th>
<th>User configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Volume Flow Cutoff</td>
<td>8 m³/hr to 37.5 m³/hr, depending on sensor</td>
<td></td>
</tr>
<tr>
<td>Density Measurement Unit</td>
<td>kg/m³</td>
<td>As desired.</td>
</tr>
<tr>
<td>Slug High Limit</td>
<td>1.01 g/cm³</td>
<td>As desired</td>
</tr>
<tr>
<td>Slug Low Limit</td>
<td>0.2 g/cm³</td>
<td>As desired</td>
</tr>
<tr>
<td>Slug Duration</td>
<td>0.1 second</td>
<td>As desired</td>
</tr>
<tr>
<td>Density Cutoff</td>
<td>200 kg/m³</td>
<td>As desired</td>
</tr>
<tr>
<td>API Table Type and other petroleum measurement parameters</td>
<td>23B</td>
<td>As desired</td>
</tr>
<tr>
<td>Discrete Event 1</td>
<td>Process Variable = Aeration Limit</td>
<td>Micro Motion recommends leaving this at the default.</td>
</tr>
<tr>
<td></td>
<td>Type = HI</td>
<td></td>
</tr>
<tr>
<td></td>
<td>HI PV = 20</td>
<td></td>
</tr>
<tr>
<td>Discrete Event 2</td>
<td>Process Variable = Aeration Limit</td>
<td>Micro Motion recommends leaving this at the default.</td>
</tr>
<tr>
<td></td>
<td>Type = HI</td>
<td></td>
</tr>
<tr>
<td></td>
<td>HI PV = 75</td>
<td></td>
</tr>
<tr>
<td>Discrete Output 1</td>
<td>Assignment = Discrete Event 1</td>
<td>Micro Motion recommends leaving this at the default.</td>
</tr>
<tr>
<td>Discrete Output 2</td>
<td>Assignment = Discrete Event 2</td>
<td>Micro Motion recommends leaving this at the default.</td>
</tr>
<tr>
<td>Discrete Output 3</td>
<td>Assignment = None</td>
<td>• For Basic and Basic/MID systems, available for customer assignment.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• For Profile and Profile/MID systems, must be set to RS485 Dual Function.</td>
</tr>
<tr>
<td>Protocol</td>
<td>Printer</td>
<td></td>
</tr>
<tr>
<td>Printer</td>
<td>Epson TMT88</td>
<td>As appropriate for installed ticket printer.</td>
</tr>
<tr>
<td>Baud Rate</td>
<td>38400</td>
<td>As appropriate for installed ticket printer.</td>
</tr>
<tr>
<td>Parity</td>
<td>Even</td>
<td>Micro Motion recommends leaving this at the default.</td>
</tr>
<tr>
<td>Data Bits</td>
<td>8</td>
<td>Micro Motion recommends leaving this at the default.</td>
</tr>
<tr>
<td>Stop Bits</td>
<td>1</td>
<td>Micro Motion recommends leaving this at the default.</td>
</tr>
<tr>
<td>Characters Per Second</td>
<td>400</td>
<td>As appropriate for installed ticket printer.</td>
</tr>
<tr>
<td>Print Buffer Size</td>
<td>1024</td>
<td>As appropriate for installed ticket printer.</td>
</tr>
</tbody>
</table>
Configure bunker ticket options using the transmitter display

The bunker ticket contains a standard set of process and bunker data, and can be configured to include additional process and bunker data. You can print one, two, or three tickets automatically.

**Prerequisites**

To configure bunker ticket options, the transmitter must be unsecured.

**Procedure**

1. Navigate to the Format Ticket menu.
2. Define Header 1, Header 2, and Footer as desired.

   **Tip**
   
   You can change the header and footer parameters while the transmitter is secured. This allows you to use them for bunker-specific information if desired (for example, vessel name, purchaser name, and so on).

3. Choose Item Display Options and select the items to be printed on the ticket.

   **Important**
   
   If you will be measuring bunker transfers in both directions (loading and unloading), you must enable Mass Inventory.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mass Inventory</td>
<td>Total mass of all bunkers transferred since the last inventory reset, plus the two forward inventories and the two reverse inventories. Labels and values depend on the setting of the Mass In Air option.</td>
</tr>
<tr>
<td>Average Temperature</td>
<td>Temperature of the process fluid, averaged across the entire bunker and expressed as a batch-weighted average with the configured volume unit used as the batch.</td>
</tr>
<tr>
<td>Average API Density</td>
<td>Average density of the bunker, at reference temperature.</td>
</tr>
<tr>
<td>Aeration Limit</td>
<td>Value of Aeration Limit at the end of the bunker transfer.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Bunker Result(1)</td>
<td>Pass: The bunker transfer passed all four OIML/MID checks.</td>
</tr>
<tr>
<td></td>
<td>Fail: The bunker transfer failed one or more of the four OIML/MID checks.</td>
</tr>
<tr>
<td>Bunker Result Details</td>
<td>Individual results for the four OIML/MID checks:</td>
</tr>
<tr>
<td></td>
<td>• MMQ check</td>
</tr>
<tr>
<td></td>
<td>• Max Aeration check</td>
</tr>
<tr>
<td></td>
<td>• Alarm check</td>
</tr>
<tr>
<td></td>
<td>• Power check</td>
</tr>
<tr>
<td></td>
<td>These are printed only if Bunker Result = Fail.</td>
</tr>
<tr>
<td>Mass In Air</td>
<td>OFF: The total and inventory values on the ticket represent “true mass,” or “mass in vacuum.” The following labels are used:</td>
</tr>
<tr>
<td></td>
<td>• Mass Total</td>
</tr>
<tr>
<td></td>
<td>• Bunker Begin Fwd Inv</td>
</tr>
<tr>
<td></td>
<td>• Bunker End Fwd Inv</td>
</tr>
<tr>
<td></td>
<td>• Bunker Begin Rev Inv</td>
</tr>
<tr>
<td></td>
<td>• Bunker End Rev Inv</td>
</tr>
<tr>
<td></td>
<td>ON: The total and inventory values on the ticket represent “mass in air,” and the Mass in Air conversion factor is printed on the ticket. The following labels are used:</td>
</tr>
<tr>
<td></td>
<td>• Mass in Air</td>
</tr>
<tr>
<td></td>
<td>• Begin Fwd Inv Air</td>
</tr>
<tr>
<td></td>
<td>• End Fwd Inv Air</td>
</tr>
<tr>
<td></td>
<td>• Begin Rev Inv Air</td>
</tr>
<tr>
<td></td>
<td>• End Rev Inv Air</td>
</tr>
<tr>
<td>Gross Volume Total</td>
<td>Total volume of the bunker, calculated from the mass total and the average density of the bunker at process temperature. The mass total is based on both aerated and non-aerated flow. The average density is based on non-aerated flow. For this calculation, aerated flow is defined as any flow occurring while drive gain exceeds a preset limit or density exceeds preset limits.</td>
</tr>
<tr>
<td>Net Volume Total</td>
<td>Total volume of the bunker, calculated from the mass total and the average density of the bunker, corrected to 15 °C. The mass total is based on both aerated and non-aerated flow. The average density is based on non-aerated flow. For this calculation, aerated flow is defined as any flow occurring while drive gain exceeds a preset limit or density exceeds preset limits.</td>
</tr>
</tbody>
</table>
### Option Description

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| SPRING TC Parameters | ON: All ticket data is printed as configured.  
|                   | OFF: The following items are not printed, whether or not they were configured:  
|                   | • “Approved Measurement” banner  
|                   | • Gross Volume Total  
|                   | • Net Volume Total  
|                   | • Average API Density  
|                   | • Average Temperature  
|                   | • Aeration Limit  
|                   | • Bunker Result  
|                   | • Bunker Result Details  
|                   | • MID Certificate Number  
|                   | • Measurement accuracy statement  
|                   | If SPRING TC Parameters is set to OFF, the bunker ticket cannot be used as a legal receipt. |

(1) For Basic/MID and Profile/MID systems, Bunker Results is enabled and cannot be disabled.

---

**Note**

Certain items are always included on the ticket, and cannot be disabled.

4. Set Number of Tickets to the number of tickets to be printed by a single PRINT command.

   The default value is 3. The range is 1 to 3.

   On the first ticket, the word “Original” is printed at the bottom of the ticket. On the second and third tickets, the word “Copy” is printed at the bottom of the ticket.

**Tip**

You can change the Number of Tickets setting while the transmitter is secured.

---

### 4.3.1 Mass in air

Micro Motion flowmeters provide a “true mass” or “mass in vacuum” value for mass measurement. Weigh scales provide a “mass in air” value. Due to the buoyancy effect of the air around the object being weighed, the “mass in air” value is lower than the “mass in vacuum” value.

If Mass In Air is enabled, the transmitter will calculate the “mass in air” value, and print the “mass in air” total on the bunker ticket instead of the Mass Total (“mass in vacuum”) value.

To calculate “mass in air”, the transmitter multiplies the Mass Total value by the Mass In Air conversion factor: 0.998925. This constant is based on environmental conditions at sea level.
4.4 Configure communications

If you have a Basic or Basic/MID system, you must configure communications between the transmitter and the ticket printer. If you have a Profile or Profile/MID system, you must configure communications between the transmitter and the ticket printer and between the transmitter and ProLink II.

4.4.1 Configure communications for a Basic or Basic/MID system

This configuration allows you to print bunker tickets on the ticket printer.

Prerequisites

The transmitter must be unsecured.

Procedure

1. At the transmitter, navigate to the Management menu.

   Tip
   If you are at the Marine Bunkering dashboard, press the Security button.

2. Choose Configuration > Digital Communication.
3. Set Protocol to Printer.
4. Choose Configure Printer and set Printer Selection as required:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Epson TMU295</td>
<td>Standard ticket printer. Does not meet OIML/MID requirements. Use this option for Basic or Profile systems.</td>
</tr>
<tr>
<td>Epson TMT88</td>
<td>MID-approved ticket printer. Use this option for Basic/MID or Profile/MID systems.</td>
</tr>
</tbody>
</table>

5. Set other parameters as shown in the following table.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Basic and Profile systems</th>
<th>Basic/MID and Profile/MID systems</th>
</tr>
</thead>
<tbody>
<tr>
<td>Baud Rate</td>
<td>9600</td>
<td>38400</td>
</tr>
<tr>
<td>Parity</td>
<td>Even</td>
<td>Even</td>
</tr>
<tr>
<td>Data Bits</td>
<td>8</td>
<td>8</td>
</tr>
<tr>
<td>Parameter</td>
<td>Basic and Profile systems</td>
<td>Basic/MID and Profile/MID systems</td>
</tr>
<tr>
<td>----------------------</td>
<td>---------------------------</td>
<td>----------------------------------</td>
</tr>
<tr>
<td>Stop Bits</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>Characters Per Second</td>
<td>32</td>
<td>400</td>
</tr>
<tr>
<td>Print Buffer Size</td>
<td>128</td>
<td>1024</td>
</tr>
<tr>
<td>Lines Per Page</td>
<td>25 (not configurable)</td>
<td>25 (not configurable)</td>
</tr>
</tbody>
</table>

**Note**
Header Line 1, Header Line 2, and Footer were configured during ticket configuration. The display shows the configured values.

6. (Optional) To test ticket printing, press EXIT to return to the previous menu, then press Printer Test.

**Need help?** If the ticket fails to print:
- Verify that the communications parameters in the transmitter are set appropriately for your printer.
- Verify that the DIP switches on the printer are set as recommended. See Appendix B.
- Verify that the DIP switches on the signal converter are set as recommended. See Appendix B.
- Verify all wiring between the transmitter and the printer. See Appendix A.

### 4.4.2 Configure communications for a Profile or Profile/MID system

This configuration allows you to print bunker tickets on the ticket printer, to send data to the ProLink II bunkering database, and to print profile reports on the PC printer.

**Prerequisites**
The transmitter must be unsecured.

**Procedure**

1. At the transmitter, navigate to the Management menu.

   **Tip**
   If you are at the Marine Bunkering dashboard, press the Security button.

2. Choose Configuration > Digital Communication.
3. Set Protocol to Printer.
4. Choose Configure Printer and set Printer Selection as required:
Configure the system using the transmitter display

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Epson TMU295</td>
<td>Standard ticket printer. Does not meet OIML/MID requirements. Use this option</td>
</tr>
<tr>
<td></td>
<td>for Basic or Profile systems.</td>
</tr>
<tr>
<td>Epson TMT88</td>
<td>MID-approved ticket printer. Use this option for Basic/MID or Profile/MID</td>
</tr>
<tr>
<td></td>
<td>systems.</td>
</tr>
</tbody>
</table>

5. Set other parameters as shown in the following table.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Basic and Profile systems</th>
<th>Basic/MID and Profile/MID systems</th>
</tr>
</thead>
<tbody>
<tr>
<td>Baud Rate</td>
<td>9600</td>
<td>38400</td>
</tr>
<tr>
<td>Parity</td>
<td>Even</td>
<td>Even</td>
</tr>
<tr>
<td>Data Bits</td>
<td>8</td>
<td>8</td>
</tr>
<tr>
<td>Stop Bits</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>Characters Per Second</td>
<td>32</td>
<td>400</td>
</tr>
<tr>
<td>Print Buffer Size</td>
<td>128</td>
<td>1024</td>
</tr>
<tr>
<td>Lines Per Page</td>
<td>25 (not configurable)</td>
<td>25 (not configurable)</td>
</tr>
</tbody>
</table>

Note
Header Line 1, Header Line 2, and Footer were configured during ticket configuration. The display shows the configured values.

6. (Optional) To test ticket printing, press EXIT to return to the previous menu, then press Printer Test.

Need help? If the ticket fails to print:
• Verify that the communications parameters in the transmitter are set appropriately for your printer.
• Verify that the DIP switches on the printer are set as recommended. See Appendix B.
• Verify that the DIP switches on the signal converter are set as recommended. See Appendix B.
• Verify all wiring between the transmitter and the printer. See Appendix A.

7. Set Protocol to Modbus RTU.

This is required because the ProLink II connection will be made before any tickets are printed. The system runs in RS-485 mode, and switches to Printer protocol automatically when printing tickets. After the ticket has printed, the system switches back to RS-485 mode.

8. (Optional) If you want to change the transmitter’s address from the default (1), choose Configure Protocol and set Polling Address to the desired address.

9. (Optional) To test the connection from ProLink II:
   a. Start ProLink II and choose Connection > Connect to Device.
b. In the ProLink II Connection dialog box, set Baud Rate, Parity, Stop Bits, and Address to the values that you set in the transmitter. Set Serial Port to the PC port that you are using for the connection. Then click Connect.

c. Using the transmitter display, fix Discrete Output 3 (Management > Maintenance > Diagnostics > Simulate Outputs > Discrete Outputs > Discrete Output 3 > On).

The ProLink II connection will be broken, as shown in the ProLink II menu bar.

d. Using the transmitter display, unfix Discrete Output 3.

ProLink II should reconnect automatically.

10. At the PC where ProLink II is installed, change the power options so that Windows will not turn off the monitor or the hard disks or go into standby mode during a bunker transfer.

To change the power options, use the Windows Control Panel.

Tip
Micro Motion recommends setting the PC power options to Never.

4.5 Secure and seal the transmitter

Securing the transfer protects it from accidental or unauthorized configuration changes. To meet Weights & Measures requirements (Basic/MID or Profile/MID systems), the transmitter must be sealed after it is secured.

Prerequisites

Before securing the transmitter, ensure that all parameters are configured correctly, all required tests and calibrations have been performed, and that the system is performing correctly. After the transmitter has been secured, only basic operational procedures can be performed.

If you are setting up a Basic/MID or Profile/MID system, review the sealing instructions in *Micro Motion Series 3000 MVD Transmitters and Controllers: Configuration and Use Manual* and arrange for a site visit from a certified Weights & Measures inspector.

Procedure

1. To secure the transmitter, set the security switch on the transmitter to ON.

   See *Micro Motion Series 3000 MVD Transmitters and Controllers: Configuration and Use Manual* for detailed instructions on securing the transmitter.

Note

Although you can perform bunker transfers while the transmitter is unsecured, the ticket will contain a Security Breach banner, and the transfer will not meet OIML/MID requirements.
2. **(Optional)** To seal the transmitter, a wire seal must be installed in the designated location on the transmitter housing.

   See *Micro Motion Series 3000 MVD Transmitters and Controllers: Configuration and Use Manual* for detailed instructions on sealing the transmitter. This function is typically performed by the Micro Motion service technician.

---

**Note**

You do not need to seal the transmitter to perform bunker transfers. Sealing the transmitter is required only if the bunker transfer must meet Weights & Measures requirements (Basic/MID or Profile/MID systems).
Configure the system using the transmitter display
5 Operate the system from the transmitter display

Topics covered in this chapter:

- Transfer a bunker and print a ticket
- Transfer a bunker, collect profile data, and print a ticket and/or a profile report
- Marine Bunkering dashboard during bunker transfer
- Process variables during a bunker transfer
- Process noise due to vibration
- Contents of bunker ticket for Basic and Profile systems
- Contents of bunker ticket for Basic/MID and Profile/MID systems
- Retrieve and reprint bunker tickets using the transmitter display

5.1 Transfer a bunker and print a ticket

This procedure guides you through transferring a bunker and printing a bunker ticket. For Basic systems, ticket printing is optional. For Basic/MID systems, ticket printing is required.

Tip
If you want to print bunker-specific information on the bunker ticket, e.g., the vessel name, you can change the settings of Header 1, Header 2, and Footer while the transmitter is secured. You can also change the setting of Number of Tickets while the transmitter is secured.

Prerequisites

Ensure that the transmitter is secured.

Ensure that you are complying with all other applicable procedures, e.g., procedures for your barge or vessel, procedures for OIML/MID compliance, etc.

Ensure that Mass Flow Rate is 0.0.

Check startup values:

- Shore facilities and vessels: Ensure that Mass Total is 0.0, or the site-specific Systemic Holdup value that was configured for your system during commissioning. If it is not, press the Print button to reset the totals.
- Barges: Ensure that Mass Total is 0.0. If it is not, press the Print button to reset the totals. If this does not correct the problem, contact Micro Motion.

Tip
If your system does not include a ticket printer, a Reset button is displayed instead of the Print button. Press Reset to reset the totals.
Take appropriate precautions to ensure that flow occurs in only one direction during the bunker transfer. Small amounts of backflow due to valve action or other mechanical issues are insignificant, but larger amounts will affect measurement accuracy.

During the bunker transfer, take appropriate steps to ensure that Mass Flow Rate does not hover around 0. Very low values for Mass Flow Rate can affect measurement accuracy. Low values for Mass Flow Rate at the beginning and end of the bunker transfer have insignificant effects.

### Procedure

1. At the Marine Bunkering dashboard, select Bunker Operations.

   **Tip**
   
   If you are not at the Marine Bunkering dashboard, press the Exit button as required until the Marine Bunkering dashboard is displayed.

2. Start flow and totalizers.

   If you have installed and configured the system as recommended, totalizers will be started automatically when liquid is detected in the pipeline. If a transmitter power cycle has occurred, totalizing does not begin until system startup procedures are complete.

3. At the Marine Bunkering dashboard, monitor bunker delivery and aeration. If necessary, take appropriate steps to reduce aeration.

   **Tips**
   
   - At 20% of Maximum Measured Quantity (MMQ), the display reports conditions of medium and high aeration. At 100% of MMQ, the display reports the current value of Aeration Limit.
   - During the bunker transfer, you can stop and restart flow as required. If you have installed and configured the system as recommended, totalizers will be stopped and restarted automatically.

4. To end the bunker transfer:

   a. Stop flow.

   b. Press the Print button on the transmitter.

   **Important**
   
   - For systems without a ticket printer, a Reset button is displayed instead of the Print button. Use the Reset button to end the transfer.
   - The Print button (or Reset button) is not available until Mass Flow Rate is 0 and the totals are non-zero.
   - If the ticket queue in the transmitter contains unprinted tickets, transfer data will be lost when additional tickets are printed. Print the current ticket, then print all unprinted tickets before performing another bunker transfer. If this is the case, the transmitter displays an informational message.
• If the value Mass Total contains more digits than the display can handle, the transmitter shows 0 R (where “R” is the rollover indicator). However, because the underlying value is non-zero, the Print button is available.

The bunker ticket is printed on the ticket printer. If you have configured the system for multiple tickets, all tickets are printed at this time. All totals are automatically reset in preparation for the next bunker transfer. If Systemic Holdup is non-zero, it is applied now.

5. To view transfer data, see the bunker ticket. To determine the total amount transferred, see the following table.

**Table 5-1: Bunker transfer total from bunker ticket**

<table>
<thead>
<tr>
<th>Installation</th>
<th>Flow Direction setting</th>
<th>Bunker transfer total</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shore facility or vessel</td>
<td>Forward Only or Negate Forward</td>
<td>Any of the following: • Mass Total • Mass in Air • Bunker End Forward Inv − Bunker Begin Forward Inv • End Fwd Inv Air − Begin Fwd Inv Air</td>
</tr>
<tr>
<td>Barge</td>
<td>Bi-directional</td>
<td>Bunker End Forward Inv − Bunker Begin Forward Inv or End Fwd Inv Air − Begin Fwd Inv Air</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Transfer in opposite direction from Flow Direction arrow on sensor</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Bunker End Reverse Inv − Bunker Begin Reverse Inv or End Rev Inv Air − Begin Rev Inv Air</td>
</tr>
</tbody>
</table>

5.1.1 **Systemic Holdup**

Systemic Holdup is a site-specific value that is calculated and configured during commissioning by the Micro Motion technician. It represents the amount of process fluid that may exist between the meter and the transfer point, or in the pipeworks, that cannot be measured by the meter because it has not flowed through the sensor.

When totals are reset at the end of a bunker transfer, in preparation for the next transfer, the Mass Total value is adjusted by the configured value of Systemic Holdup. Therefore, the value of Mass Total at the beginning of the transfer may not be 0.0.

**Restriction**

Systemic Holdup is not applicable to installations that use bi-directional measurement. These installations are typically barges. For all installations of this type, the value of Mass Total at the beginning of the transfer should always be 0.0.
The need for Systemic Holdup can be eliminated by good bunkering practices: Always have the pipeworks in the same state before and after the bunker transfer: either full/full or empty/empty.

**Important**
If you need to change the setting of Systemic Holdup, or if you want to change your bunkering procedures in a way that affects the fullness of the pipeworks before or after a bunker transfer, contact Micro Motion.

### 5.2 Transfer a bunker, collect profile data, and print a ticket and/or a profile report

This procedure guides you through transferring a bunker, collecting profile data, and printing a bunker ticket and/or a profile report, using the transmitter display. For Profile systems, ticket printing is optional. For Profile/MID systems, ticket printing is required.

**Tip**
If you want to print bunker-specific information on the bunker ticket, e.g., the vessel name, you can change the settings of Header 1, Header 2, and Footer while the transmitter is secured. You can also change the setting of Number of Tickets while the transmitter is secured.

**Prerequisites**

To print a bunker ticket, your system must include a ticket printer.

Ensure that the transmitter is secured.

Ensure that you are complying with all other applicable procedures, e.g., procedures for your barge or vessel, procedures for OIML/MID compliance, etc.

Ensure that Mass Flow Rate is 0.0.

Check startup values:

- Shore facilities and vessels: Ensure that Mass Total is 0.0, or the site-specific Systemic Holdup value that was configured for your system during commissioning. If it is not, press the Print button to reset the totals.
- Barges: Ensure that Mass Total is 0.0. If it is not, press the Print button to reset the totals. If this does not correct the problem, contact Micro Motion.

**Tip**
If your system does not include a ticket printer, a Reset button is displayed instead of the Print button. Press Reset to reset the totals.

Take appropriate precautions to ensure that flow occurs in only one direction during the bunker transfer. Small amounts of backflow due to valve action or other mechanical issues are insignificant, but larger amounts will affect measurement accuracy.
During the bunker transfer, take appropriate steps to ensure that Mass Flow Rate does not hover around 0. Very low values for Mass Flow Rate can affect measurement accuracy. Low values for Mass Flow Rate at the beginning and end of the bunker transfer have insignificant effects.

The transmitter must be ready to accept a connection from ProLink II. If you have trouble making the connection:

- Ensure that communications have been configured for a Profile or Profile/MID system.
- Ensure that the RS-485 terminals are in RS-485 mode, rather than service port mode.

**Procedure**

1. Connect from ProLink II to the transmitter.
   a. Start ProLink II.
   b. Click Connection > Connect to Device.
   c. Set Protocol, Baud Rate, Parity, and Stop Bits to the values configured in the transmitter.
   d. Set Serial Port to the PC port you are using for the connection.
   e. Set Address to the value configured for the transmitter. The default address is 1.
   f. Click Connect.

   If the connection is successful, the Marine Bunkering window is displayed.

   **Tip**
   To open the Marine Bunkering window, if you have closed it, choose Tools > Marine Bunker Transfer.

   **Important**
   For best results, ensure that ProLink II is connected to the transmitter for the entire bunker transfer. If the connection is dropped, data in the profile report and the ProLink II bunkering database will be incomplete. Check the power options on the PC and ensure that Windows will not turn off the monitor or the hard disks or go into standby mode during the bunker transfer.

2. Start flow and totalizers.

   If you have installed and configured the system as recommended, totalizers will be started automatically when liquid is detected in the pipeline. If a transmitter power cycle has occurred, totalizing does not begin until system startup procedures are complete.

3. At the Marine Bunkering dashboard, monitor bunker delivery and aeration. If necessary, take appropriate steps to reduce aeration.
Tips

- At 20% of Maximum Measured Quantity (MMQ), the display reports conditions of medium and high aeration. At 100% of MMQ, the display reports the current value of Aeration Limit.
- During the bunker transfer, you can stop and restart flow as required. If you have installed and configured the system as recommended, totalizers will be stopped and restarted automatically.

4. To end the bunker transfer:
   a. Stop flow.
   b. Press the Print button, then select Print Ticket or Print Ticket & Report.

Important

- For systems without a ticket printer, a Reset button is displayed instead of the Print button. Use the Reset button to end the transfer.
- The Print button (or Reset button) is not available until Mass Flow Rate is 0 and the totals are non-zero.
- If the ticket queue in the transmitter contains unprinted tickets, transfer data will be lost when additional tickets are printed. Print the current ticket, then print all unprinted tickets before performing another bunker transfer. If this is the case, the transmitter displays an informational message.
- If the value Mass Total contains more digits than the display can handle, the transmitter shows 0 R (where “R” is the rollover indicator). However, because the underlying value is non-zero, the Print button is available.

The bunker ticket is printed on the ticket printer. If you have configured the system for multiple tickets, all tickets are printed at this time. The profile report is printed through ProLink II, and will appear on the default printer for the PC. All totals are automatically reset in preparation for the next bunker transfer. If Systemic Holdup is non-zero, it is applied now.

5. To view transfer data, see the bunker ticket. To determine the total amount transferred, see the following table.

Table 5-2: Bunker transfer total from bunker ticket

<table>
<thead>
<tr>
<th>Installation</th>
<th>Flow Direction setting</th>
<th>Bunker transfer total</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shore facility or vessel</td>
<td>Forward Only or Negate Forward</td>
<td>Any of the following:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Mass Total</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Mass in Air</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Bunker End Forward Inv − Bunker Begin Forward Inv</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• End Fwd Inv Air − Begin Fwd Inv Air</td>
</tr>
<tr>
<td>Barge</td>
<td>Bi-directional</td>
<td>Bunker End Forward Inv − Bunker Begin Forward Inv</td>
</tr>
<tr>
<td></td>
<td></td>
<td>or</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• End Fwd Inv Air − Begin Fwd Inv Air</td>
</tr>
</tbody>
</table>
5.2.1 Systemic Holdup

Systemic Holdup is a site-specific value that is calculated and configured during commissioning by the Micro Motion technician. It represents the amount of process fluid that may exist between the meter and the transfer point, or in the pipeworks, that cannot be measured by the meter because it has not flowed through the sensor.

When totals are reset at the end of a bunker transfer, in preparation for the next transfer, the Mass Total value is adjusted by the configured value of Systemic Holdup. Therefore, the value of Mass Total at the beginning of the transfer may not be 0.0.

Restriction
Systemic Holdup is not applicable to installations that use bi-directional measurement. These installations are typically barges. For all installations of this type, the value of Mass Total at the beginning of the transfer should always be 0.0.

The need for Systemic Holdup can be eliminated by good bunkering practices: Always have the pipeworks in the same state before and after the bunker transfer: either full/full or empty/empty.

Important
If you need to change the setting of Systemic Holdup, or if you want to change your bunkering procedures in a way that affects the fullness of the pipeworks before or after a bunker transfer, contact Micro Motion.

5.3 Marine Bunkering dashboard during bunker transfer

During a bunker transfer, the Marine Bunkering dashboard displays process variables that track the transfer.

Table 5-3: Process variables on Marine Bunkering dashboard

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mass Flow Rate</td>
<td>Current value of the process variable</td>
<td></td>
</tr>
</tbody>
</table>
Table 5-3: Process variables on Marine Bunkering dashboard (continued)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mass Total</td>
<td>Current value of the process variable</td>
<td>Measured since the last time the totals were reset (totals are reset automatically when an original ticket is printed or the Reset button is pressed).</td>
</tr>
<tr>
<td>Aeration Limit Fail</td>
<td>Measurement accuracy value for the current mass total, expressed as a percentage of the maximum allowable measurement error as defined by OIML/MID</td>
<td>Not displayed until the transfer reaches Minimum Measured Quantity (MMQ).</td>
</tr>
</tbody>
</table>
| Medium Aeration Limit | • ON: The current value of Aeration Limit is above 20%  
• OFF: The current value of Aeration Limit is below 20% | 20% is the default value. It can be changed by changing the value of HI PV defined for Discrete Event 1. |
| High Aeration Limit | • ON: The current value of Aeration Limit is above 75%  
• OFF: The current value of Aeration Limit is below 75% | 75% is the default value. It can be changed by changing the value of HI PV defined for Discrete Event 2. |
| API Density    | Current value of the process variable     |                                                                          |
| Temperature    | Current value of the process variable     |                                                                          |
| Drive Gain     | Current value of the diagnostic variable  |                                                                          |
| Field Verify Zero | Current value of the diagnostic variable |                                                                          |

5.4 Process variables during a bunker transfer

Due to the algorithms used to calculate the marine bunkering process variables, the transmitter may temporarily display values that do not reflect the current process.

Aeration Limit

Aeration Limit is not shown on the transmitter display until the transfer total reaches 20% of MMQ.

At the beginning of the transfer, the end of the transfer, and any time that the flow rate is near 0, Aeration Limit may be very high. The overall effect on measurement accuracy is insignificant unless the flow rate was near 0 for extended periods.

Volume totals and inventories

Volume Inventory is calculated from the real-time density data, and the inventory starts counting when the bunker starts.

Volume Total, Gross Volume Total, and Net Volume Total are calculated from average density data. Average density data is not calculated until the first ton of fluid has been measured. Until that time, these process variables are reported as 0. After one ton of fluid has been measured, the totalizer starts counting, applying the average density data to the measured mass and continuing forward.
5.5 Process noise due to vibration

Vibration generated by an external influence (for example, a pump) can influence the current meter measurement. Overall bunker accuracy and long-term measurement accuracy are not affected.

There are isolated instances when a specific vibration generated from an external influence (a pump, for instance) can influence the meter measurement. The interference causes a sinusoidal noise on the meter signal, although it does not affect the long-term accuracy of the meter.

If the interference is present, it is easily diagnosed by logging the mass flow rate using ProLink II, ProLink III, or a similar tool. Instead of a very stable mass flow signal, you will see a signal that has a very distinct sinusoidal characteristic. The amplitude of the noise will be less than approximately 1% of nominal flow rate. (For nominal flow rates, refer to the product data sheet for your sensor.)

If you observe measurement disturbances that may be caused by external vibration, consult the factory for assistance.

5.6 Contents of bunker ticket for Basic and Profile systems

Note
Some items are optional and are printed only if selected during ticket configuration.

<table>
<thead>
<tr>
<th>Ticket item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Micro Motion Inc, Business Unit of Emerson</td>
<td>Banner printed at top of ticket</td>
</tr>
<tr>
<td>Header 1</td>
<td>User-defined text</td>
</tr>
<tr>
<td>Header 2</td>
<td>User-defined text</td>
</tr>
<tr>
<td>Transmitter Tag Name</td>
<td>User-configured string</td>
</tr>
<tr>
<td>System ID</td>
<td>HART software tag configured in the transmitter</td>
</tr>
<tr>
<td>BOL Number</td>
<td>Bill of Lading number, assigned automatically by the transmitter</td>
</tr>
<tr>
<td>Reset Time</td>
<td>Date and time that totals were reset, either by printing an original ticket or by pressing Reset</td>
</tr>
<tr>
<td>Print Time</td>
<td>Date and time that the original ticket was printed</td>
</tr>
<tr>
<td>Bunker Begin Time</td>
<td>Date and time that the transmitter started bunker measurement</td>
</tr>
<tr>
<td>Bunker End Time</td>
<td>Date and time that the transmitter stopped bunker measurement</td>
</tr>
<tr>
<td>Mass Total</td>
<td>Total mass of bunker, as measured by transmitter</td>
</tr>
<tr>
<td>Mass in Air</td>
<td>Total mass of bunker multiplied by the Mass in Air conversion factor</td>
</tr>
<tr>
<td>Mass Inventory</td>
<td>Total mass of all bunkers transferred since the last inventory reset</td>
</tr>
</tbody>
</table>
### Table 5-4: Contents of bunker ticket for Basic and Profile systems (continued)

<table>
<thead>
<tr>
<th>Ticket item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bunker Begin Forward Inventory</td>
<td>Value of Mass Forward Inventory at the beginning of the bunker transfer</td>
</tr>
<tr>
<td>Bunker End Forward Inventory</td>
<td>Value of Mass Forward Inventory at the end of the bunker transfer</td>
</tr>
<tr>
<td>Bunker Begin Reverse Inventory</td>
<td>Value of Mass Reverse Inventory at the beginning of the bunker transfer</td>
</tr>
<tr>
<td>Bunker End Reverse Inventory</td>
<td>Value of Mass Reverse Inventory at the end of the bunker transfer</td>
</tr>
<tr>
<td>Begin Forward Inventory Air</td>
<td>Value of Mass Forward Inventory at the beginning of the bunker transfer, multiplied by the Mass in Air conversion factor</td>
</tr>
<tr>
<td>End Forward Inventory Air</td>
<td>Value of Mass Forward Inventory at the end of the bunker transfer, multiplied by the Mass in Air conversion factor</td>
</tr>
<tr>
<td>Begin Reverse Inventory Air</td>
<td>Value of Mass Reverse Inventory at the beginning of the bunker transfer, multiplied by the Mass in Air conversion factor</td>
</tr>
<tr>
<td>End Reverse Inventory Air</td>
<td>Value of Mass Reverse Inventory at the end of the bunker transfer, multiplied by the Mass in Air conversion factor</td>
</tr>
<tr>
<td>Gross Volume Total</td>
<td>Total volume of the bunker, calculated from the mass total and the average density of the bunker at process temperature. The mass total is based on both aerated and non-aerated flow. The average density is based on non-aerated flow. For this calculation, aerated flow is defined as any flow occurring while drive gain exceeds a preset limit or density exceeds preset limits.</td>
</tr>
<tr>
<td>Net Volume Total</td>
<td>Total volume of the bunker, calculated from the mass total and the average density of the bunker, corrected to 15 °C. The mass total is based on both aerated and non-aerated flow. The average density is based on non-aerated flow. For this calculation, aerated flow is defined as any flow occurring while drive gain exceeds a preset limit or density exceeds preset limits.</td>
</tr>
<tr>
<td>Average Temperature</td>
<td>Average temperature of bunker, calculated as batch-weighted average with the configured volume unit used as the batch</td>
</tr>
<tr>
<td>Average API Density</td>
<td>Average density of the bunker, corrected to reference temperature</td>
</tr>
<tr>
<td>Aeration Limit</td>
<td>Value of Aeration Limit at the end of the bunker transfer</td>
</tr>
<tr>
<td>Alarm Occurred</td>
<td>• Yes: One or more bunker-critical alarms was posted during the bunker transfer</td>
</tr>
<tr>
<td></td>
<td>• No: No bunker-critical alarm was posted during the bunker transfer</td>
</tr>
<tr>
<td>Aeration Limit</td>
<td>• Pass: The value of Aeration Limit at the end of the transfer was within good-practice limits</td>
</tr>
<tr>
<td></td>
<td>• Fail: The value of Aeration Limit at the end of the transfer was not within good-practice limits</td>
</tr>
<tr>
<td>Minimum Quantity</td>
<td>• Pass: Mass Total ≥ MMQ (Minimum Measured Quantity)</td>
</tr>
<tr>
<td></td>
<td>• Fail: Mass Total &lt; MMQ</td>
</tr>
<tr>
<td>No Power Interrupt</td>
<td>• Pass: No power reset occurred during bunker transfer</td>
</tr>
<tr>
<td></td>
<td>• Fail: Power reset occurred during bunker transfer</td>
</tr>
<tr>
<td>Overall Bunker Results</td>
<td>Represents the combined results of the four OIML/MID checks:</td>
</tr>
<tr>
<td></td>
<td>• Pass: The bunker transfer measurement passed all four checks, and meets good-practice requirements.</td>
</tr>
<tr>
<td></td>
<td>• Fail: The bunker transfer measurement failed one or more checks, and does not meet good-practice requirements.</td>
</tr>
</tbody>
</table>
5.6.1 Sample bunker tickets for Basic and Profile systems

These examples show bunker tickets for Basic and Profile systems, under different configurations and different Pass/Fail conditions. The date and time values are based on the transmitter date and time.

**Example: Basic or Profile ticket: Print no optional items**

In the following sample ticket, the system is configured to print no optional items. The SPRING TC parameters are enabled.

**Note**
The ticket does not indicate whether the bunker transfer passed or failed any of the four checks. This may or may not be significant in your installation.

---

Micro Motion Inc, Business Unit of Emerson
[Header 1]
[Header 2]

[Transmitter Tag]

System ID: [HART ID]

BOL Number: [xx]

Reset Time: 26-MAR-2011 17:14:49

Print Time: 26-MAR-2011 17:17:46

Bunker Begin Time: 26-MAR-2011 17:15:21

Bunker End Time: 26-MAR-2011 18:17:17

---

### Table 5-4: Contents of bunker ticket for Basic and Profile systems (continued)

<table>
<thead>
<tr>
<th>Ticket item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mass in Air footer</td>
<td>Statement of the Mass in Air conversion factor</td>
</tr>
<tr>
<td>IMPORTANT: Attach this ticket to BDN Report</td>
<td>Banner printed at bottom of ticket</td>
</tr>
<tr>
<td>Footer</td>
<td>User-defined text</td>
</tr>
<tr>
<td>Original</td>
<td>Printed automatically on the first printed ticket</td>
</tr>
<tr>
<td>Copy</td>
<td>Printed automatically on the second or third ticket</td>
</tr>
<tr>
<td>Duplicate Receipt</td>
<td>Printed automatically on all duplicate (reprinted) tickets</td>
</tr>
<tr>
<td>SECURITY BREACH Not A Legal Receipt</td>
<td>Banner printed at bottom of ticket if a security breach occurred during the transfer</td>
</tr>
</tbody>
</table>
**Example: Basic or Profile ticket: Print Mass Inventory**

In the following sample ticket, the system is configured to print Mass Inventory. The SPRING TC parameters are enabled. The forward and reverse inventories are printed automatically. A small amount of reverse flow occurred.

**Note**
The ticket does not indicate whether the bunker transfer passed or failed any of the four checks. This may or may not be significant in your installation.
Example: Basic or Profile ticket: Print all optional items; bunker transfer passed

In the following sample ticket, the system is configured to print all optional items. The SPRING TC parameters are enabled. The bunker transfer passed all four checks.

Micro Motion Inc, Business Unit of Emerson
[Header 1]
[Header 2]

[Transmitter Tag]
System ID: [HART ID]
BOL Number: [xx]
Reset Time
26-MAR-2011 17:14:49
Print Time
26-MAR-2011 17:17:46
Bunker Begin Time
26-MAR-2011 17:15:21
Bunker End Time
26-MAR-2011 18:17:17
Mass in Air
32.9446 t
Mass Inventory
1432.2420 t
Begin Fwd Inv Air
1420.3915 t
End Fwd Inv Air
1452.3817 t
Begin Rev Inv Air
1403.6547 t
End Rev Inv Air
1403.6710 t
Gross Volume Total
32.9801 t
Net Volume Total
32.7492 t
Average Temperature
98.35 degF
Average API Density
0.93132 g/cm3
Aeration Limit
0.0029 %
Overall Bunker: Pass

The mass vacuum to mass air conversion factor is: 0.998925
Example: Basic or Profile ticket: Print all optional items; bunker transfer failed

In the following sample ticket, the system is configured to print all optional items. The SPRING TC parameters are enabled. The bunker transfer failed one of the four checks (the MMQ check).

Micro Motion Inc, Business Unit of Emerson

System ID: [HART ID]
BOL Number: [xx]

Reset Time
26-MAR-2011 17:14:49

Print Time
26-MAR-2011 17:17:46

Bunker Begin Time
26-MAR-2011 17:15:21

Bunker End Time
26-MAR-2011 18:17:17

Mass in Air
32.9446 t

Mass Inventory
1432.2420 t

Begin Fwd Inv Air
1420.3915 t

End Fwd Inv Air
1452.3817 t

Begin Rev Inv Air
1403.6547 t

End Rev Inv Air
1403.6710 t

Gross Volume Total
32.9801 t

Net Volume Total
32.7492 t

Average Temperature
98.35 degF

Average API Density
0.93132 g/cm3

Alarm Occurred: No
Aeration Limit: Pass
Minimum Quantity: Fail
No Power Interrupt: Pass
Overall Bunker: Fail
The mass vacuum to mass air conversion factor is: 0.998925

IMPORTANT: Attach this ticket to BDN Report

## 5.7 Contents of bunker ticket for Basic/MID and Profile/MID systems

**Note**

Some items are optional and are printed only if selected during ticket configuration.

<table>
<thead>
<tr>
<th>Ticket item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><em>Approved Measurement</em></td>
<td>Banner printed at top and bottom of ticket if Overall Bunker = Pass</td>
</tr>
<tr>
<td>Micro Motion Inc, Business Unit of Emerson</td>
<td>Banner printed at top of ticket</td>
</tr>
<tr>
<td>Header 1</td>
<td>User-defined text</td>
</tr>
<tr>
<td>Header 2</td>
<td>User-defined text</td>
</tr>
<tr>
<td>Transmitter Tag Name</td>
<td>User-configured string</td>
</tr>
<tr>
<td>System ID</td>
<td>HART software tag configured in the transmitter</td>
</tr>
<tr>
<td>BOL Number</td>
<td>Bill of Lading number, assigned automatically by the transmitter</td>
</tr>
<tr>
<td>Reset Time</td>
<td>Date and time that totals were reset, either by printing an original ticket or by pressing Reset</td>
</tr>
<tr>
<td>Print Time</td>
<td>Date and time that the original ticket was printed</td>
</tr>
<tr>
<td>Bunker Begin Time</td>
<td>Date and time that the transmitter started bunker measurement</td>
</tr>
<tr>
<td>Bunker End Time</td>
<td>Date and time that the transmitter stopped bunker measurement</td>
</tr>
<tr>
<td>Mass Total</td>
<td>Total mass of bunker, as measured by transmitter</td>
</tr>
<tr>
<td>Mass in Air</td>
<td>Total mass of bunker multiplied by the Mass in Air conversion factor</td>
</tr>
<tr>
<td>Mass Inventory</td>
<td>Total mass of all bunkers transferred since the last inventory reset</td>
</tr>
<tr>
<td>Bunker Begin Forward Inventory</td>
<td>Value of Mass Forward Inventory at the beginning of the bunker transfer</td>
</tr>
<tr>
<td>Bunker End Forward Inventory</td>
<td>Value of Mass Forward Inventory at the end of the bunker transfer</td>
</tr>
<tr>
<td>Bunker Begin Reverse Inventory</td>
<td>Value of Mass Reverse Inventory at the beginning of the bunker transfer</td>
</tr>
<tr>
<td>Bunker End Reverse Inventory</td>
<td>Value of Mass Reverse Inventory at the end of the bunker transfer</td>
</tr>
<tr>
<td>Begin Forward Inventory Air</td>
<td>Value of Mass Forward Inventory at the beginning of the bunker transfer, multiplied by the Mass in Air conversion factor</td>
</tr>
</tbody>
</table>
### Table 5-5: Contents of bunker ticket for Basic/MID and Profile/MID systems (continued)

<table>
<thead>
<tr>
<th>Ticket item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>End Forward Inventory Air</td>
<td>Value of Mass Forward Inventory at the end of the bunker transfer, multiplied by the Mass in Air conversion factor</td>
</tr>
<tr>
<td>Begin Reverse Inventory Air</td>
<td>Value of Mass Reverse Inventory at the beginning of the bunker transfer, multiplied by the Mass in Air conversion factor</td>
</tr>
<tr>
<td>End Reverse Inventory Air</td>
<td>Value of Mass Reverse Inventory at the end of the bunker transfer, multiplied by the Mass in Air conversion factor</td>
</tr>
<tr>
<td>Gross Volume Total</td>
<td>Total volume of the bunker, calculated from the mass total and the average density of the bunker at process temperature. The mass total is based on both aerated and non-aerated flow. For this calculation, aerated flow is defined as any flow occurring while drive gain exceeds a preset limit or density exceeds preset limits.</td>
</tr>
<tr>
<td>Net Volume Total</td>
<td>Total volume of the bunker, calculated from the mass total and the average density of the bunker, corrected to 15 °C. The mass total is based on both aerated and non-aerated flow. For this calculation, aerated flow is defined as any flow occurring while drive gain exceeds a preset limit or density exceeds preset limits.</td>
</tr>
<tr>
<td>Average Temperature</td>
<td>Average temperature of bunker, calculated as batch-weighted average with the configured volume unit used as the batch</td>
</tr>
<tr>
<td>Average API Density</td>
<td>Average density of the bunker, corrected to reference temperature</td>
</tr>
<tr>
<td>Aeration Limit</td>
<td>Value of Aeration Limit at the end of the bunker transfer</td>
</tr>
</tbody>
</table>
| Alarm Occurred               | • Yes: One or more bunker-critical alarms was posted during the bunker transfer  
• No: No bunker-critical alarm was posted during the bunker transfer                                                                                                                                          |
| Aeration Limit               | • Pass: The value of Aeration Limit at the end of the transfer was within OIML/MID limits  
• Fail: The value of Aeration Limit at the end of the transfer was not within OIML/MID limits                                                                                                             |
| Minimum Quantity             | • Pass: Mass Total ≥ MMQ (Minimum Measured Quantity)  
• Fail: Mass Total < MMQ                                                                                                                                                                                   |
| No Power Interrupt           | • Pass: No power reset occurred during bunker transfer  
• Fail: Power reset occurred during bunker transfer                                                                                                                                                         |
| Overall OIML R117-1 Accuracy | Represents the combined results of the four OIML/MID checks:  
• Pass: The bunker transfer measurement passed all four checks, and meets OIML/MID requirements.  
• Fail: The bunker transfer measurement failed one or more checks, and does not meet OIML/MID requirements.                                                                                              |
| *Accuracy within x.x%        | Statement of measurement accuracy for the bunker transfer                                                                                                                                                      |
| MID Certificate #            | Certificate number for this Micro Motion system, obtained and configured during commissioning                                                                                                                    |
| Mass in Air footer           | Statement of the Mass in Air conversion factor                                                                                                                                                                 |
| IMPORTANT: Attach this ticket to BDN Report | Banner printed at bottom of ticket                                                                                                                                                                           |
Table 5-5: Contents of bunker ticket for Basic/MID and Profile/MID systems (continued)

<table>
<thead>
<tr>
<th>Ticket item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Footer</td>
<td>User-defined text</td>
</tr>
<tr>
<td>Original</td>
<td>Printed automatically on the first printed ticket</td>
</tr>
<tr>
<td>Copy</td>
<td>Printed automatically on the second or third ticket</td>
</tr>
<tr>
<td>Duplicate Receipt</td>
<td>Printed automatically on all duplicate (reprinted) tickets</td>
</tr>
<tr>
<td>SECURITY BREACH Not A Legal Receipt</td>
<td>Banner printed at bottom of ticket if a security breach occurred during the transfer</td>
</tr>
</tbody>
</table>

5.7.1 Sample bunker tickets for Basic/MID and Profile/MID systems

These examples show bunker tickets for Basic/MID and Profile/MID systems, under different configurations and different Pass/Fail conditions. The date and time values are based on the transmitter date and time.

**Example: Basic/MID and Profile/MID tickets: Print no optional items; bunker transfer passed; no security breach occurred**

In the following sample ticket, the system is configured to print no optional items. The SPRING TC parameters are enabled. The bunker transfer met OIML/MID requirements, and no security breach occurred.

*Approved Measurement*
Micro Motion Inc, Business Unit of Emerson
/Header 1
/Header 2

[Transmitter Tag]
System ID: [HART ID]
BOL Number: [xx]
Reset Time
10-JAN-2012 9:48:53
Print Time
10-JAN-2012 9:51:37
Bunker Begin Time
10-JAN-2012 9:51:14
Bunker End Time
10-JAN-2012 9:51:30
Mass Total
*7.1317 t*
MID Cert#: xxxx
**Example: Basic/MID and Profile/MID tickets: Print Mass Inventory; bunker transfer passed; no security breach occurred**

In the following sample ticket, the system is configured to print Mass Inventory. The SPRING TC parameters are enabled. The forward and reverse inventories are printed automatically. No reverse flow occurred. The bunker transfer met OIML/MID requirements, and no security breach occurred.

*Approved Measurement*

Micro Motion Inc, Business Unit of Emerson

[Header 1]

[Header 2]

[Transmitter Tag]

System ID: [HART ID]

BOL Number: [xx]

Reset Time
10-JAN-2012 9:48:53

Print Time
10-JAN-2012 9:51:37

Bunker Begin Time
10-JAN-2012 9:51:14

Bunker End Time
10-JAN-2012 9:51:30

Mass Total
*6.2995 t*

Mass Inventory
6034.5977 t
Bunker Begin Fwd Inv
6218.1221 t
Bunker End Fwd Inv
6224.4219 t
Bunker Begin Rev Inv
196.3344 t
Bunker End Rev Inv
196.3344 t

MID Cert#: xxxx

*Approved Measurement*

IMPORTANT: Attach this
Example: Basic/MID and Profile/MID tickets: Print no optional items; security breach occurred

In the following sample ticket, the system is configured to print no optional items. The SPRING TC parameters are enabled. A security breach occurred.

Micro Motion Inc, Business Unit of Emerson
[Header 1]
[Header 2]

[Transmitter Tag]
System ID: [HART ID]
BOL Number: [xx]

Reset Time
10-JAN-2012 9:51:49
Print Time
10-JAN-2012 9:52:40
Bunker Begin Time
10-JAN-2012 9:52:17
Bunker End Time
10-JAN-2012 9:52:33

Mass Total
7.2606 t

MID Cert#: xxxx
IMPORTANT: Attach this ticket to BDN Report
[Footer]

Original
SECURITY BREACH
Not A Legal Receipt

Example: Basic/MID and Profile/MID tickets: Print all optional items; bunker transfer passed; no security breach

In the following sample ticket, the system is configured to print all optional items. The SPRING TC parameters are enabled. The bunker transfer met OIML/MID requirements and no security breach occurred. No reverse flow occurred.

*Approved Measurement*
Micro Motion Inc, Business Unit of Emerson
[Header 1]
[Header 2]
[Transmitter Tag]

System ID: [HART ID]

BOL Number: [xx]

Reset Time
10-JAN-2012 9:52:52

Print Time
10-JAN-2012 9:54:36

Bunker Begin Time
10-JAN-2012 17:15:21

Bunker End Time
10-JAN-2012 18:17:17

Mass in Air
6.2995 t

Mass Inventory
6034.5977 t

Begin Fwd Inv Air
6218.1221 t

End Fwd Inv Air
6224.4219 t

Begin Rev Inv Air
196.3344 t

End Rev Inv Air
196.3344 t

Gross Volume Total
0.0000 m³

Net Volume Total
6034.4111 m³

Average Temperature
98.63 degF

Average API Density
0.93132 g/cm³

Aeration Limit
71.42876 %

Overall OIML R117-1 Accuracy: Pass
*Accuracy within 0.5%

MID Cert#: xxxx

The mass vacuum to mass air conversion factor is: 0.998925

*Approved Measurement*

IMPORTANT: Attach this ticket to BDN Report

[Footer]
Example: Basic/MID and Profile/MID tickets: Print all optional items; bunker transfer failed; no security breach

In the following sample ticket, the system is configured to print all optional items. The SPRING TC parameters are enabled. No reverse flow occurred. The bunker transfer failed one of the four checks (the MMQ check) and did not meet OIML/MID requirements.

Micro Motion Inc, Business Unit of Emerson

[Header 1]
[Header 2]

[Transmitter Tag]

System ID: [HART ID]

BOL Number: [xx]

Reset Time
10-JAN-2012 9:54:51

Print Time
10-JAN-2012 9:55:42

Bunker Begin Time
10-JAN-2012 09:55:30

Bunker End Time
10-JAN-2012 9:55:35

Mass in Air
32.9446 t

Mass Inventory
6036.6841 t

Begin Fwd Inv Air
6224.4219 t

End Fwd Inv Air
6226.5063 t

Begin Rev Inv Air
196.3344 t

End Rev Inv Air
196.3344 t

Gross Volume Total
0.0000 m3

Net Volume Total
6036.4980 m3

Average Temperature
98.63 degF

Average API Density
0.93132 g/cm3

Aeration Limit
71.4286 %

Alarm Occurred: No
Aeration Limit: Pass
Minimum Quantity: Fail
No Power Interrupt: Pass
Overall OIML R117-1 Accuracy: Fail
Retrieve and reprint bunker tickets using the transmitter display

Ticket data for the five previous bunker transfers is stored on the transmitter. You can retrieve the data for viewing, and you can print duplicate tickets. You can also use this function to recover from print failures.

1. At the Marine Bunkering dashboard, choose Bunker Ticket Log.

   **Tip**
   If you are not at the Marine Bunkering dashboard, press the Exit button as required until the Marine Bunkering dashboard is displayed.

   Up to five tickets are listed, by BOL number. The most recent is listed first. For each ticket:
   - (P): The ticket has been printed successfully.
   - (F): The ticket has not been printed successfully.

2. Select a ticket.
3. Use the Up Arrow and Down Arrow buttons to view all ticket data.
4. If desired, press Print to print the selected ticket. If profile data was collected during the bunker transfer and ProLink II is currently connected, you can also print a duplicate profile report.

If the ticket has previously been printed, the new ticket will be a duplicate ticket and the “Duplicate Receipt” banner is automatically added to the ticket. If the ticket has not been previously printed, the banner is not added to the ticket.

**Important**
- The ticket will be printed with the current settings for Header, Footer, and Number of Tickets.
- The ticket will be printed according to the currently configured bunker ticket options (Bunker Result, Bunker Result Details, Mass In Air, etc.).
6 Use ProLink II with the Marine Bunkering Transfer Package

Topics covered in this chapter:

• Configure bunker ticket options using ProLink II
• Transfer a bunker using ProLink II
• Print or reprint a bunker ticket using ProLink II
• View bunker transfer history
• Contents of profile report
• Print or export bunker transfer data using ProLink II
• Maintain bunker transfer history

6.1 Configure bunker ticket options using ProLink II

You can use ProLink II to configure the bunker ticket contents and printing options. The configuration parameters are stored in the transmitter, and will overwrite the existing ticket configuration.

Tip
These parameters are typically set during system startup and should not require changing.

Prerequisites

To configure bunker ticket options, the transmitter must be unsecured.

The transmitter must be ready to accept a connection from ProLink II. If you have trouble making the connection:

• Ensure that communications have been configured for a Profile or Profile/MID system.
• Ensure that the RS-485 terminals are in RS-485 mode, rather than service port mode.

Procedure

1. Connect from ProLink II to the transmitter.
   a. Start ProLink II.
   b. Click Connection > Connect to Device .
   c. Set Protocol, Baud Rate, Parity, and Stop Bits to the values configured in the transmitter.
d. Set Serial Port to the PC port you are using for the connection.

e. Set Address to the value configured for the transmitter. The default address is 1.

f. Click Connect.

If the connection is successful, the Marine Bunkering window is displayed.

**Tip**

To open the Marine Bunkering window, if you have closed it, choose Tools > Marine Bunker Transfer.

---

2. Select the Configuration panel in the Marine Bunkering window.

3. In the Ticket Process Information group, select all items that you want to be included on the ticket.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Aeration Limit</td>
<td>Value of Aeration Limit at the end of the bunker transfer.</td>
</tr>
<tr>
<td>Bunker Result(1)</td>
<td>Pass: The bunker transfer passed all four OIML/MID checks.</td>
</tr>
<tr>
<td></td>
<td>Fail: The bunker transfer failed one or more of the four OIML/MID checks.</td>
</tr>
<tr>
<td>Gross Volume Total</td>
<td>Total volume of the bunker, calculated from the mass total and the average density of the bunker at process temperature. The mass total is based on both aerated and non-aerated flow. The average density is based on non-aerated flow. For this calculation, aerated flow is defined as any flow occurring while drive gain exceeds a preset limit or density exceeds preset limits.</td>
</tr>
<tr>
<td>Mass Inventory</td>
<td>Total mass of all bunkers transferred since the last inventory reset, plus the two forward inventories and the two reverse inventories. Labels and values depend on the setting of the Mass In Air option.</td>
</tr>
<tr>
<td>Bunker Result Details</td>
<td>Individual results for the four OIML/MID checks:</td>
</tr>
<tr>
<td></td>
<td>• MMQ check</td>
</tr>
<tr>
<td></td>
<td>• Max Aeration check</td>
</tr>
<tr>
<td></td>
<td>• Alarm check</td>
</tr>
<tr>
<td></td>
<td>• Power check</td>
</tr>
<tr>
<td></td>
<td>These are printed only if Bunker Result = Fail.</td>
</tr>
<tr>
<td>Net Volume Total</td>
<td>Total volume of the bunker, calculated from the mass total and the average density of the bunker, corrected to 15 °C. The mass total is based on both aerated and non-aerated flow. The average density is based on non-aerated flow. For this calculation, aerated flow is defined as any flow occurring while drive gain exceeds a preset limit or density exceeds preset limits.</td>
</tr>
<tr>
<td>Average Temperature</td>
<td>Temperature of the process fluid, averaged across the entire bunker and expressed as a batch-weighted average with the configured volume unit used as the batch.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Mass In Air               | ON: The total and inventory values on the ticket represent “mass in air,” and the Mass in Air conversion factor is printed on the ticket. The following labels are used:  
  • Mass in Air  
  • Begin Fwd Inv Air  
  • End Fwd Inv Air  
  • Begin Rev Inv Air  
  • End Rev Inv Air  

  OFF: The total and inventory values on the ticket represent “true mass,” or “mass in vacuum.” The following labels are used:  
  • Mass Total  
  • Bunker Begin Fwd Inv  
  • Bunker End Fwd Inv  
  • Bunker Begin Rev Inv  
  • Bunker End Rev Inv |
| Average API Density       | Average density of the bunker, at reference temperature.                                                                                     |
| SPRING TC Parameters      | ON: All ticket data is printed as configured.  

  OFF: The following items are not printed, whether or not they were configured:  
  • “Approved Measurement” banner  
  • Gross Volume Total  
  • Net Volume Total  
  • Average API Density  
  • Average Temperature  
  • Aeration Limit  
  • Bunker Result  
  • Bunker Result Details  
  • MID Certificate Number  
  • Measurement accuracy statement  

  If SPRING TC Parameters is set to OFF, the bunker ticket cannot be used as a legal receipt. |

(1) For Basic/MID and Profile/MID systems, Bunker Results is enabled and cannot be disabled.

**Note**  
Certain items are always included on the ticket, and cannot be disabled.

4. Configure headers, footers, and related parameters.
   a. In the Header and Footer group, configure Header Line 1, Header Line 2, and Footer to the text to be printed on the ticket.
   b. Set Header Font Size and Footer Font Size to the font height to be used on the ticket.
5. Set Number of Tickets to the number of tickets to be printed with one print command.

The default value is 3. The range is 1 to 3.

On the first ticket, the word “Original” is printed at the bottom of the ticket. On the second and third tickets, the word “Copy” is printed at the bottom of the ticket.

Tip
You can change the header and footer parameters while the transmitter is secured. This allows you to use them for bunker-specific information if desired (for example, vessel name, purchaser name, and so on).

Tip
You can change the Number of Tickets setting while the transmitter is secured.

6.2 Transfer a bunker using ProLink II

This procedure guides you through transferring a bunker, collecting profile data, and printing a bunker ticket and/or a profile report, using ProLink II. For Profile systems, ticket printing is optional. For Profile/MID systems, ticket printing is required. You can also print a line graph of four process variables.

Tip
If you want to print bunker-specific information on the bunker ticket, e.g., the vessel name, you can change the settings of Header 1, Header 2, and Footer while the transmitter is secured. You can also change the setting of Number of Tickets while the transmitter is secured.

Prerequisites

To print a bunker ticket, your system must include a ticket printer.

Ensure that the transmitter is secured.

Ensure that you are complying with all other applicable procedures, e.g., procedures for your barge or vessel, procedures for OIML/MID compliance, etc.

Ensure that Mass Flow Rate is 0.0.

Check startup values:

- Shore facilities and vessels: Ensure that Mass Total is 0.0, or the site-specific Systemic Holdup value that was configured for your system during commissioning. If it is not, press the Print button to reset the totals.

- Barges: Ensure that Mass Total is 0.0. If it is not, press the Print button to reset the totals. If this does not correct the problem, contact Micro Motion.

Tip
If your system does not include a ticket printer, a Reset button is displayed instead of the Print button. Press Reset to reset the totals.
Take appropriate precautions to ensure that flow occurs in only one direction during the bunker transfer. Small amounts of backflow due to valve action or other mechanical issues are insignificant, but larger amounts will affect measurement accuracy.

During the bunker transfer, take appropriate steps to ensure that Mass Flow Rate does not hover around 0. Very low values for Mass Flow Rate can affect measurement accuracy. Low values for Mass Flow Rate at the beginning and end of the bunker transfer have insignificant effects.

The transmitter must be ready to accept a connection from ProLink II. If you have trouble making the connection:

- Ensure that communications have been configured for a Profile or Profile/MID system.
- Ensure that the RS-485 terminals are in RS-485 mode, rather than service port mode.

**Procedure**

1. Connect from ProLink II to the transmitter.
   
   a. Start ProLink II.
   b. Click **Connection > Connect to Device**.
   c. Set Protocol, Baud Rate, Parity, and Stop Bits to the values configured in the transmitter.
   d. Set Serial Port to the PC port you are using for the connection.
   e. Set Address to the value configured for the transmitter. The default address is 1.
   f. Click Connect.

   If the connection is successful, the Marine Bunkering window is displayed.

   **Tip**
   To open the Marine Bunkering window, if you have closed it, choose Tools > Marine Bunker Transfer.

2. Start flow and totalizers.

   If you have installed and configured the system as recommended, totalizers will be started automatically when liquid is detected in the pipeline. If a transmitter power cycle has occurred, totalizing does not begin until system startup procedures are complete.

3. Use the Monitor panel in the Marine Bunkering window to observe process data.

   The Monitor panel displays current values of six process variables, and a line graph of four process variables.

   **Tip**
   You can use Drive Gain to track aeration (entrained gas or entrained air) during the bunker transfer. Drive Gain is a measure of the energy required to vibrate the sensor tubes to full amplitude. When aeration is present, more energy is required and the drive gain increases.
dramatically. The maximum value of Drive Gain is 100%. Note that other process and equipment conditions can cause result in higher Drive Gain values. For more information, see Micro Motion Series 3000 MVD Transmitters and Controllers: Configuration and Use Manual.

4. (Optional) To print the line graph from the Marine Bunkering window while a bunker transfer is in progress, click Print Graph.

5. To end the bunker transfer:
   a. Stop flow.
   b. Click the Print Ticket button on the Monitor panel.

      If your system does not include a ticket printer, a Reset button is displayed instead of the Print Ticket button. Click Reset to end the transfer.

      The Print Ticket and Reset buttons in ProLink II have the same functions as the Print and Reset buttons on the face of the transmitter. Totals are reset and a bunker ticket is printed (if a ticket printer is available). If Systemic Holdup is non-zero, it is applied now.

6. (Optional) To preview or print a profile report, click the Preview button or the Print Report button on the Monitor panel.

      These buttons are not available until a ticket has been printed. You may need to wait a few seconds after clicking Print Ticket.

### 6.3 Print or reprint a bunker ticket using ProLink II

You can print or reprint the bunker ticket for any bunker transfer in the ProLink II bunkering database. You can use this function to recover from print failures.

1. Connect ProLink II to the transmitter.
2. Select the History panel in the Marine Bunkering window.
3. Select the desired transfer record from Historical Transfer Log Index.

   Transfer records are ordered by timestamp. Historical Transfer 1 is the most recent bunker transfer.

4. Click Print Ticket to print or reprint a ticket.

If the ticket has previously been printed, the new ticket will be a duplicate ticket and the "Duplicate Receipt" banner is automatically added to the ticket. If the ticket has not been previously printed, the banner is not added to the ticket.

**Important**

- The ticket will be printed with the current settings for Header, Footer, and Number of Tickets.
- The ticket will be printed according to the currently configured bunker ticket options (Bunker Result, Bunker Result Details, Mass In Air, etc.).
6.4 View bunker transfer history

You can view history data for all bunker transfers that are recorded in the ProLink II bunkering database. The bunkering database can store data for up to five bunker transfers.

Prerequisites

The transmitter must be ready to accept a connection from ProLink II. If you have trouble making the connection:

- Ensure that communications have been configured for a Profile or Profile/MID system.
- Ensure that the RS-485 terminals are in RS-485 mode, rather than service port mode.

Procedure

1. Connect from ProLink II to the transmitter.
   a. Start ProLink II.
   b. Click Connection > Connect to Device.
   c. Set Protocol, Baud Rate, Parity, and Stop Bits to the values configured in the transmitter.
   d. Set Serial Port to the PC port you are using for the connection.
   e. Set Address to the value configured for the transmitter. The default address is 1.
   f. Click Connect.

   If the connection is successful, the Marine Bunkering window is displayed.

   Tip
   To open the Marine Bunkering window, if you have closed it, choose Tools > Marine Bunker Transfer.

2. Select the History panel.
3. Select the desired transfer record from Historical Transfer Log Index.

   Transfer records are ordered by timestamp. Historical Transfer 1 is the most recent bunker transfer.

   The History panel is updated with data from the selected transfer record.

4. (Optional) Click Preview or Print to preview or print the profile report for the currently selected bunker transfer.
6.5 Contents of profile report

Table 6-1: Contents of profile report

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Header 1</td>
<td>User-defined text</td>
</tr>
<tr>
<td>Header 2</td>
<td>User-defined text</td>
</tr>
<tr>
<td>BOL Number</td>
<td>Bill of Lading number, assigned automatically by the transmitter</td>
</tr>
<tr>
<td>Reset Time</td>
<td>Date and time that totals were reset, either by printing an original ticket or by pressing Reset</td>
</tr>
<tr>
<td>Print Time</td>
<td>Date and time that the original ticket was printed</td>
</tr>
<tr>
<td>Bunker Begin Time</td>
<td>Date and time that the transmitter started bunker measurement</td>
</tr>
<tr>
<td>Bunker End Time</td>
<td>Date and time that the transmitter stopped bunker measurement</td>
</tr>
<tr>
<td>Mass in Air</td>
<td>Total mass of bunker multiplied by the Mass in Air conversion factor</td>
</tr>
<tr>
<td>Mass Total</td>
<td>Total mass of bunker, as measured by transmitter</td>
</tr>
<tr>
<td>Mass Inventory</td>
<td>Total mass of all bunkers transferred since the last inventory reset</td>
</tr>
<tr>
<td>Bunker Begin Forward Inventory</td>
<td>Value of Mass Forward Inventory at the beginning of the bunker transfer</td>
</tr>
<tr>
<td>Bunker End Forward Inventory</td>
<td>Value of Mass Forward Inventory at the end of the bunker transfer</td>
</tr>
<tr>
<td>Bunker Begin Reverse Inventory</td>
<td>Value of Mass Reverse Inventory at the beginning of the bunker transfer</td>
</tr>
<tr>
<td>Bunker End Reverse Inventory</td>
<td>Value of Mass Reverse Inventory at the end of the bunker transfer</td>
</tr>
<tr>
<td>Gross Volume Total</td>
<td>Total volume of the bunker, calculated from the mass total and the average density of the bunker at process temperature. The mass total is based on both aerated and non-aerated flow. The average density is based on non-aerated flow. For this calculation, aerated flow is defined as any flow occurring while drive gain exceeds a preset limit or density exceeds preset limits.</td>
</tr>
<tr>
<td>Net Volume Total</td>
<td>Total volume of the bunker, calculated from the mass total and the average density of the bunker, corrected to 15 °C. The mass total is based on both aerated and non-aerated flow. The average density is based on non-aerated flow. For this calculation, aerated flow is defined as any flow occurring while drive gain exceeds a preset limit or density exceeds preset limits.</td>
</tr>
<tr>
<td>Average Temperature</td>
<td>Average temperature of bunker, calculated as batch-weighted average with the configured volume unit used as the batch</td>
</tr>
<tr>
<td>Average API Density</td>
<td>Average density of the bunker, corrected to reference temperature</td>
</tr>
<tr>
<td>Aeration Limit</td>
<td>Value of Aeration Limit at the end of the bunker transfer</td>
</tr>
<tr>
<td></td>
<td>• Pass: The value of Aeration Limit at the end of the transfer was within OIML/MID limits</td>
</tr>
<tr>
<td></td>
<td>• Fail: The value of Aeration Limit at the end of the transfer was not within OIML/MID limits</td>
</tr>
<tr>
<td>Alarm Occurred</td>
<td>• Yes: One or more bunker-critical alarms was posted during the bunker transfer</td>
</tr>
<tr>
<td></td>
<td>• No: No bunker-critical alarm was posted during the bunker transfer</td>
</tr>
<tr>
<td>Minimum Quantity</td>
<td>• Pass: Mass Total ≥ MMQ (Minimum Measured Quantity)</td>
</tr>
<tr>
<td></td>
<td>• Fail: Mass Total &lt; MMQ</td>
</tr>
</tbody>
</table>
### Table 6-1: Contents of profile report (continued)

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>No Power Interrupt</td>
<td>• Pass: No power reset occurred during bunker transfer</td>
</tr>
<tr>
<td></td>
<td>• Fail: Power reset occurred during bunker transfer</td>
</tr>
<tr>
<td>Overall Bunker Results</td>
<td>Represents the combined results of the four OIML/MID checks:</td>
</tr>
<tr>
<td></td>
<td>• Pass: The bunker transfer measurement passed all four checks, and meets</td>
</tr>
<tr>
<td></td>
<td>good-practice requirements.</td>
</tr>
<tr>
<td></td>
<td>• Fail: The bunker transfer measurement failed one or more checks, and does</td>
</tr>
<tr>
<td></td>
<td>not meet good-practice requirements.</td>
</tr>
<tr>
<td>Meter Verification Test Results</td>
<td>• Pass: The flowmeter passed the most recent meter verification test.</td>
</tr>
<tr>
<td></td>
<td>• Fail: The flowmeter failed the most recent meter verification test.</td>
</tr>
<tr>
<td></td>
<td>If the Meter Verification application is not present on the transmitter, this</td>
</tr>
<tr>
<td></td>
<td>item is blank.</td>
</tr>
<tr>
<td>Bunker Profile graph</td>
<td>Line graph of Mass Flow Rate, Average Density at Reference Temperature, Tem-</td>
</tr>
<tr>
<td></td>
<td>perature, and Drive Gain during the bunker transfer</td>
</tr>
<tr>
<td>MID Certificate #</td>
<td>Certificate number for this Micro Motion system, obtained and configured du-</td>
</tr>
<tr>
<td></td>
<td>ring commissioning</td>
</tr>
<tr>
<td>Mass in Air footer</td>
<td>Statement of the Mass in Air conversion factor</td>
</tr>
<tr>
<td>Footer</td>
<td>User-defined text</td>
</tr>
</tbody>
</table>
6.5.1 Sample profile reports

Figure 6-1: Sample profile report for Profile systems

To convert mass to mass in air, multiply by 0.998925.
Figure 6-2: Sample profile report for Profile/MID systems

Bunker Delivery Verification
Micro Motion Inc., Business Unit of Emerson
FUEL OIL
v8.10

BOL Number: 256
Reset Time: 19-Jan-12 15:06:00
Print Time: 19-Jan-12 15:07:22
Bunker Begin Time: 19-Jan-12 15:06:47
Bunker End Time: 19-Jan-12 15:07:00
Mass In Vacuum: 14.62141 mTon
Mass In Air: 14.60569 mTon
Mass Total: 14.62141 mTon
Mass Inventory: 54.90598 mTon
Bunker Begin Forward Mass Inventory: 40.20147 mTon
Bunker End Forward Mass Inventory: 54.82288 mTon
Bunker Begin Reverse Mass Inventory: 0.00007 mTon
Bunker End Reverse Mass Inventory: 0.00007 mTon
Gross Volume Total: 0.00000 m3
Net Volume Total: 62.46829 m3
Average Temperature: N.A. °C
Average API Density: N.A. kg/m3
Aeration Limit: 7.142857% Pass
Alarms Occurred: None
Minimum Quantity: Pass
No Power Interrupt: Pass
Overall Bunker Results: Pass With High Aeration
Accuracy within 1%

Meter Verification Test Results: Fail

To convert mass to mass in air, multiply by 0.998925.
6.6 Print or export bunker transfer data using ProLink II

You can print bunker transfer data from the current bunker transfer or from any bunker transfer in the ProLink II bunkering database. You can export bunker transfer data to Unicode CSV (comma-separated values) files for use in other applications.

- To print process data for the current bunker transfer:
  1. Ensure that ProLink II is connected to the transmitter during the bunker transfer.
  2. Select the Monitor panel in the Marine Bunkering window.
  3. Click Print Graph (if the transfer is in progress) or Print Report (if the transfer is complete).

  **Tip**
  If you want to change the appearance of the graph before you print it, right-click anywhere on the graph and use the graphics toolbox that is provided. You can also use the graphics toolbox to save the graph as an image.

- To print a profile report for a bunker transfer in the bunkering database:
  1. Connect ProLink II to the transmitter.
  2. Select the History panel in the Marine Bunkering window.
  3. Select the desired transfer record from Historical Transfer Log Index.

    Transfer records are ordered by timestamp. Historical Transfer 1 is the most recent bunker transfer.

  4. Click Preview to preview the profile report or to export the data to a CSV file.
  5. Click Print Report to print the profile report.

  **Restriction**
  You cannot use the History panel to print a profile report for the current bunker transfer while it is in progress. To print a profile report for the current bunker transfer, you must use the Marine Bunkering dashboard on the transmitter. When the transfer is complete, it is available from the History panel as Historical Transfer 1.

6.7 Maintain bunker transfer history

You can keep bunkering transfer data as long as required by storing it outside the ProLink II bunkering database.

The ProLink II bunkering database can store data for up to five bunker transfers. When the database is full, the oldest bunker transfer will be overwritten.

**Tip**
Be sure to store any required data externally before the bunker transfer is overwritten.
**Procedure**

- To keep the profile report data in both TIF format and HTML format, print the profile report.

  A graphics file in TIF format will be created and saved in the location you specify. Additionally, a set of HTML files is automatically generated and saved on your PC in a folder named Reports. Reports is located in the ProLink II installation folder. You can view the report by opening the HTML file in a browser.

- To store the corresponding trend data, export the data for the transfer to a CSV file. To do this, preview the profile report and click Export to CSV.
Appendix A
Integrated wiring diagrams

Topics covered in this appendix:

- Integrated wiring diagrams for Basic systems
- Integrated wiring diagrams for Basic/MID systems
- Integrated wiring diagrams for Profile systems
- Integrated wiring diagrams for Profile/MID systems

A.1  Integrated wiring diagrams for Basic systems

Use these integrated wiring diagrams for Basic systems only. Choose the wiring diagrams that match the direction of the pipe and the orientation of your sensor.

| Vertical pipe (Sensor orientation = Flag) | Figure A-1  
|                                           | Figure A-2 |
| Horizontal pipe (Sensor orientation = Tubes down) | Figure A-3  
|                                                    | Figure A-4 |
Figure A-1: Basic systems, vertical pipe (Sensor orientation = Flag): Sheet 1
Figure A-2: Basic systems, vertical pipe (Sensor orientation = Flag): Sheet 2
Figure A-3: Basic systems, horizontal pipe (Sensor orientation = Tubes down): Sheet 1
Figure A-4: Basic systems, horizontal pipe (Sensor orientation = Tubes down): Sheet 2
## A.2 Integrated wiring diagrams for Basic/MID systems

Use these integrated wiring diagrams for Basic/MID systems only. Choose the wiring diagrams that match the direction of the pipe and the orientation of your sensor.

<table>
<thead>
<tr>
<th>Orientation</th>
<th>Figure</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vertical pipe (Flag)</td>
<td>A-5, A-6</td>
</tr>
<tr>
<td>Horizontal pipe (Tubes down)</td>
<td>A-7, A-8</td>
</tr>
</tbody>
</table>
Figure A-5: Basic/MID systems, vertical pipe (Sensor orientation = Flag): Sheet 1
Figure A-6: Basic/MID systems, vertical pipe (Sensor orientation = Flag): Sheet 2
Figure A-7: Basic/MID systems, horizontal pipe (Sensor orientation = Tubes down): Sheet 1

Integrated wiring diagrams
Figure A-8: Basic/MID systems, horizontal pipe (Sensor orientation = Tubes down): Sheet 2
A.3 Integrated wiring diagrams for Profile systems

Use these integrated wiring diagrams for Profile systems only. Choose the wiring diagrams that match the direction of the pipe and the orientation of your sensor.

| Vertical pipe (Sensor orientation = Flag) | Figure A-9       |
|                                           | Figure A-10      |
| Horizontal pipe (Sensor orientation = Tubes down) | Figure A-11   |
|                                           | Figure A-12      |
Figure A-9: Profile systems, vertical pipe (Sensor orientation = Flag): Sheet 1
Figure A-10: Profile systems, vertical pipe (Sensor orientation = Flag): Sheet 2
Figure A-11: Profile systems, horizontal pipe (Sensor orientation = Tubes down): Sheet 1
Figure A-12: Profile systems, horizontal pipe (Sensor orientation = Tubes down): Sheet 2
A.4 Integrated wiring diagrams for Profile/MID systems

Use these integrated wiring diagrams for Profile/MID systems only. Choose the wiring diagrams that match the direction of the pipe and the orientation of your sensor.

| Vertical pipe (Sensor orientation = Flag) | Figure A-13  
|                                          | Figure A-14  
| Horizontal pipe (Sensor orientation = Tubes down) | Figure A-15  
|                                                   | Figure A-16  

Figure A-13: Profile/MID systems, vertical pipe (Sensor orientation = Flag): Sheet 1
Figure A-14: Profile/MID systems, vertical pipe (Sensor orientation = Flag): Sheet 2
Figure A-15: Profile/MID systems, horizontal pipe (Sensor orientation = Tubes down): Sheet 1
Figure A-16: Profile/MID systems, horizontal pipe (Sensor orientation = Tubes down): Sheet 2
## Appendix B
### Printer setup

### B.1 Communications settings for the ticket printer

<table>
<thead>
<tr>
<th>Component and settings</th>
<th>System type</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Basic</td>
</tr>
<tr>
<td>Printer DIP switches</td>
<td>1: OFF</td>
</tr>
<tr>
<td></td>
<td>2: OFF</td>
</tr>
<tr>
<td></td>
<td>3: OFF</td>
</tr>
<tr>
<td></td>
<td>4: OFF</td>
</tr>
<tr>
<td></td>
<td>5: ON</td>
</tr>
<tr>
<td></td>
<td>6: ON</td>
</tr>
<tr>
<td></td>
<td>7: OFF</td>
</tr>
<tr>
<td></td>
<td>8: OFF</td>
</tr>
<tr>
<td></td>
<td>9: OFF</td>
</tr>
<tr>
<td></td>
<td>10: OFF</td>
</tr>
<tr>
<td>K2-ADE-TB signal converter DIP switches</td>
<td>1: ON</td>
</tr>
<tr>
<td></td>
<td>2: OFF</td>
</tr>
<tr>
<td></td>
<td>4: ON</td>
</tr>
<tr>
<td></td>
<td>5: OFF</td>
</tr>
<tr>
<td>Transmitter digital communications</td>
<td>Baud: 9600</td>
</tr>
<tr>
<td></td>
<td>Parity: None</td>
</tr>
<tr>
<td></td>
<td>Data bits: 8</td>
</tr>
<tr>
<td></td>
<td>Stop bits: 1</td>
</tr>
<tr>
<td></td>
<td>Characters per second: 32</td>
</tr>
<tr>
<td></td>
<td>Buffer size: 512</td>
</tr>
<tr>
<td>Transmitter DO3 (discrete output)</td>
<td>As desired</td>
</tr>
</tbody>
</table>
Index

A
aeration 2, 3
Aeration Limit 3
Alarm check
  See also bunker-critical alarms
definition 2
alarms, See Alarm check; bunker-critical alarms

B
Basic system
  bunker tickets
    contents 55
    sample 57
definition 5
installation 11
operation 47
requirements 5
wiring diagrams 83
Basic/MID system
  bunker tickets
    contents 61
    sample 63
definition 5
installation 15
operation 47
requirements 6
wiring diagrams 88
bunker tickets
  configuring
    using ProLink II 69
    using the display 38
contents
  Basic system 55
  Basic/MID system 61
  Profile system 55
  Profile/MID system 61
duplicate tickets, See bunker tickets, reprinting
print failure recovery
  using ProLink II 74
  using the display 68
printing
  from ProLink II 72
  from the display 47, 50
reprinting
  from ProLink II 74
  from the display 68
retrieving
  using ProLink II 74
  using the display 68
samples
  Basic system 57
  Basic/MID system 63
  Profile system 57
  Profile/MID system 63
Weights & Measures document 2
bunker transfers
  Basic system 47
  Basic/MID system 47
history
  in the ProLink II bunkering database 75
  on the transmitter 68
monitoring
  from ProLink II 72
  from the display 53, 54
Profile system
  from ProLink II 72
  from the display 50
Profile/MID system
  from ProLink II 72
  from the display 50
bunker-critical alarms
  definition 3
  list 4

calibration
  density, See LD Optimization
  mA output, See trimming the mA outputs
  water, See LD Optimization
  zero 32
Certified Marine Bunker Measurement Solution
documentation 9
installation locations 5
overview 1
configuration, See configuring auxiliary devices;
  configuring basic flowmeter parameters; configuring
  the bunker ticket; configuring communications
configuring auxiliary devices 33
configuring basic flowmeter parameters 34
configuring communications
  Basic system 41
  Basic/MID system 41
printer settings summary 103
Profile system 42
Profile/MID system 42
configuring the bunker ticket
using ProLink II 69
using the display 38
custody transfer, See Weights & Measures
customer service
contacting ii

D
default values for flowmeter configuration 36
density calibration, See LD Optimization
documentation 1, 9
duplicate tickets, See bunker tickets, reprinting

E
entrained air, See aeration
entrained gas, See aeration

F
ferrite beads 28

H
history, See ProLink II bunkering database
hydrocarbon compensation, See LD Optimization

I
installation
Basic system 11
Basic/MID system 15
ferrite beads 28
marine approvals 28
Profile system 18
Profile/MID system 23
wiring diagrams
Basic system 83
Basic/MID system 88
Profile system 93
Profile/MID system 98
integrity detection loop
configuring the device 33
configuring the loop 34
installation 13, 16, 21, 26

L
LD Optimization 32
level switches
configuring the device 33
configuring the loop 34
installation 13, 16, 21, 26
loop tests 32

M
mA output calibration, See trimming the mA outputs
marine approvals 28
Marine Bunker Instruments
in Basic system 5
in Basic/MID system 6
in Profile system 7
in Profile/MID system 8
Marine Bunker Transfer Package
compliance with OIML R-117-1 MID 2004-22/EC
Annex MI-005 2
documentation 1, 9
installation locations 5
overview 2
system options 5, 11
system requirements 5
Marine Bunkering dashboard
contents 31
during bunker transfer 53
exiting 31
returning to 31
Mass in Air conversion 40
mass in vacuum, See Mass in Air conversion
Max Aeration check
See also aeration
definition 2
MID 2004/22/EC Annex MI-005 2
Minimum Measured Quantity, See MMQ
MMQ 2
MMQ check
See also MMQ
definition 2

O
OIML R117-1 2
operation
Basic system 47
Basic/MID system 47
Profile system
from ProLink II 72
from the display 50
Profile/MID system
from ProLink II 72
from the display 50
P
power
  applying power 31
Power check
  definition 2
pressure transmitter
  configuring the device 33
  configuring the loop 34
  installation 13, 16, 21, 26
printing
  See also bunker tickets
  See also profile reports
current bunker data 80
historical bunker data 80
profile reports
  contents 76
  printing 50, 72, 75, 80
  sample
    Profile system 78
    Profile/MID system 78
viewing 75
Profile system
bunker tickets
  contents 55
  sample 57
definition 5
installation 18
operation
  from ProLink II 72
  from the display 50
profile reports
  contents 76
  sample 78
requirements 7
wiring diagrams 93
Profile/MID system
bunker tickets
  contents 61
  sample 63
definition 5
installation 23
operation
  from ProLink II 72
  from the display 50
profile reports
  contents 76
  sample 78
requirements 8
wiring diagrams 98
ProLink II
  in Basic system 5
  in Basic/MID system 6
  in Profile system 7
  in Profile/MID system 8
ProLink II bunkering database
  data in CSV format 80
  data in HTML format 80
  exporting data 80
  maintaining history 80
  printing data 80
  viewing data 75

Q
Quick Reference Guide 9

R
RF (radio frequency) emissions 28

S
sealing the transmitter, See security
securing the transmitter, See security
  sealing the transmitter 44
  securing the transmitter 44
system options and requirements 5
system startup
  applying power 31
  optional startup tasks 32
Systemic Holdup 49, 53

T
temperature transmitter
  configuring the device 33
  configuring the loop 34
  installation 13, 16, 21, 26
tickets, See bunker tickets
transfer, See bunker transfers
trimming the mA outputs 32
true mass, See true mass, See Mass in Air conversion

W
water calibration, See LD Optimization
Weights & Measures
  bunker tickets as legal documents 2
  sealing the transmitter 44
  wiring. See installation
wiring diagrams
  Basic system 83
  Basic/MID system 88
Profile system 93
Profile/MID system 98

Z
zero calibration 32